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Software Disclaimer of Liability Clause

The Enhanced Video Analysis of Dust Exposures (EVADE) software was developed by
researchers at the National Institute for Occupational Safety and Health (NIOSH). It is provided
“as 1s” without warranty of any kind, including express or implied warranties of merchantability
or fitness for a particular purpose. By acceptance and use of this software, which is conveyed to
the user without consideration by NIOSH, the user expressly waives any and all claims for
damage and/or suits for personal injury or property damage resulting from any direct, indirect,
incidental, special or consequential damages for loss of profits, revenue, data or property use,
incurred by the user or any third party, whether in an action in contract or tort, arising from
access to, or use of, this software in whole or in part.

Any questions concerning this product can be directed to the Office of Mine Safety and Health
Research (OMSHR) via email at OMSHR@cdc.gov.

System Requirements

To run the EVADE program effectively, your computer should meet the following system
requirements:

| Operating system | Windows 2000 / XP / Vista / Windows 7
Hardware Minimum Recommended
Processor 1 gigahertz (GHz) processor 2 gigahertz (GHz) processor
or higher
Disk space 1.0 gigabyte (GB) available 4.0 gigabyte (GB) available
disk space disk space
Memory 512 MB of RAM 1.0 GB of RAM
Screen resolution 800 x 600 1024 x 768 or higher
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Guidelines for Performing a Helmet-CAM Respirable
Dust Survey and Conducting Subsequent Analysis
with the Enhanced Video Analysis of Dust Exposures
(EVADE) Software

W. Randolph Reed,' August J. Kwitowski,” William J. Helfrich,’
Andrew B. Cecala,® Gerald J. Joy’

Abstract

This report describes the process of performing a Helmet-CAM Respirable Dust Survey and
the Enhanced Video Analysis of Dust Exposures (EVADE) software program, Version 1.0, that
is designed for analyzing dust exposure in the mining environment at surface mines through the
simultaneous use of video and real-time dust concentration data. The Helmet-CAM procedure,
developed by researchers at the National Institute for Occupational Safety and Health (NIOSH)
for personal sampling of respirable dust, is a technique that uses a video camera worn by the
worker to provide a visual record of the worker’s activities concurrently with data collected by a
real-time datalogging aerosol monitor also worn by the worker. The EVADE software program
merges the video file and dust concentration data file, allowing the user to use a computer to
view them at the same time to identify potential dust exposure sources. This report defines the
input file types and provides instructions for installing and operating the EVADE software. A
step-by-step procedure is included to aid the user in conducting an analysis for identifying
respirable dust exposure sources.

! Mining Engineer, Dust Control Team, Office of Mine Safety and Health Research (OMSHR), NIOSH,
Pittsburgh, PA.

% Civil Engineer (retired), Computational Research Team, OMSHR, NIOSH, Pittsburgh, PA.
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4 Mining Engineer, Aerosol and Toxic Substances Team, OMSHR, NIOSH, Pittsburgh, PA.

® Industrial Hygienist, Dust Control Team, OMSHR, NIOSH, Pittsburgh, PA.



Introduction

The use of video in conjunction with real-time dust exposure monitoring has been employed
in the past to identify sources and routes of worker exposure to different chemical agents. The
subsequent video analysis allows for controls to be developed to prevent the exposures from the
newly identified sources. However, the drawback in past research was that the video and
sampling equipment were so large such that the video analysis was only able to be conducted at a
stationary location. Additionally, the output from the sampling was limited as it had to be
overlayed directly onto the video film which limited the analysis of the sampling data with the
video data [Rosen and Lundstrom 1987; Rosen and Andersson 1989; Gressel et al. 1988].
Advances in technology have miniaturized the video and sampling devices so that they are
portable and can be carried by the worker with minimal inconvenience. Additionally, the video
and sampling data are currently available in digital format and can be merged using a separate
software program [Rosen et al. 2005] [NIOSH 1992]. However, these programs are not
commercially available. A method to overcome the lack of availability of these programs is to
customize commercially available software to open the video and sampling data outputs in
separate windows on a computer [ Xu and McGlothlin 2003]. Another method is to develop a
software program which can merge the two data sources. This has been accomplished in past
research, but this program is not publicly available [Rosen et al. 2005].

The Enhanced Video Analysis of Dust Exposures (EVADE) software program was
developed by researchers at the National Institute for Occupational Safety and Health (NIOSH)
and 1s used for exposure analysis of workers to respirable dust. NIOSH researchers also
developed a sampling procedure using a real-time datalogging aerosol monitor and a portable
video camera (Helmet-CAM) to be used at surface mine sites to monitor respirable dust
concentrations while recording the worker’s perspective during the performance of their job.
This procedure may be difficult to use in underground mining situations because of poor
underground lighting conditions and because the real-time datalogging aerosol monitor and
portable video cameras used are not typically Mine Safety and Health Administration (MSHA)
approved for intrinsic safety (Code of Federal Regulations, Title 30, Chapter 1, Subchapter B,
Part 18.68).

The results of this monitoring are a real-time dust concentration data file and a corresponding
video file. EVADE meshes the two data files (dust concentration and video) to allow for analysis
of sources of dust exposure of workers. This software program displays a graphical depiction of
the dust concentrations synchronized to the video of the worker’s job activities, and allows for
playback, fast forward and reverse, and pause. Additionally, events with elevated dust levels can
be bookmarked in the program for more detailed review. A bookmark is a link to an individual
dust exposure event during the respirable dust sampling time period. This software allows the
user to conduct an analysis of the worker’s occupational activities and develop a source database
for respirable dust exposures at surface mine operations. The results of this analysis may lead to
the development of engineering and behavioral controls that may prevent the overexposures to
respirable dust from their sources.



Sampling Equipment

The EVADE software uses dust concentration data obtained from a respirable dust personal
sampling survey conducted on a specific job activity performed by a worker. The equipment
required for conducting the survey consists of a real-time datalogging aerosol monitor and a
video camera. NIOSH’s Office of Mine Safety and Health Research (OMSHR) typically uses
one of two devices for real-time dust sampling. The data output of these two devices are
compatible with EVADE; these devices are Thermo Scientific’s personal Data Ram™ 1000
(pDR-1000) and the Thermo Scientific personal Data Ram 1500 (pDR-lSOO)6 (Figure 1). Their
data files are compatible with the EVADE software without requiring any editing of the data
files. Another real-time datalogging aerosol monitor commonly used by the mining industry is
the Sidepak Personal Aerosol Monitor AM510 manufactured by TSI, Inc. (AM-510)". The data
output from the AM-510 is also compatible with the EVADE software. Other real-time
datalogging aerosol monitors may be available from other manufacturers. These other real-time
datalogging aerosol monitors can be used with EVADE, but currently their data output would
require being input using EVADE’s universal format. EVADE’s universal format is a four-
column comma delimited file (c¢sv) where the first column represents data point number, the
second column represents date, the third column represents time, and the fourth column
represents dust concentration (see the Data File: EVADE’s Universal Format section in this
document for guidance).

The pDR-1000, pDR-1500, and AM-510 are real-time datalogging aerosol monitors which
log dust concentrations at user-selected time intervals. The pDR-1000, pDR-1500, and AM-510
real-time datalogging aerosol monitors record the dust concentrations to a data file that can be
downloaded in the comma separated value (csv) format, which can be used by the EVADE
software.

The pDR-1000 is a passive real-time datalogging aerosol monitor with sensor response
optimized to a particle-size range with aerodynamic diameters of 0.1 um to 10 um. A passive
sampler is defined as a sampler that uses ambient airflow from the surrounding environment to
draw the surrounding air into the optical chamber to provide a dust concentration measurement.
The pDR-1500 and AM-510 are active real-time datalogging aerosol monitors which contain an
air pump used to draw in or collect dust samples at a specific user-defined flowrate and can be
used with particle-size selective separators. An active sampler uses a pump to pull the
surrounding air at a constant preset flowrate into the optical chamber to provide a dust
concentration measurement.

Sampling with active real-time datalogging aerosol monitors is preferred due to the ability of
these monitors to use particle-size selective separators to minimize sampling of large particles,
resulting in precise measurement of concentrations [Willeke and Degarmo 1988; Quintana PJE et
al. 2000; Liu LJS et al. 2002; Chakrabarti et al. 2004]. However, recently it has been found that
passive sampling with real-time datalogging aerosol monitors provides consistent results similar
to active sampling using real-time datalogging aerosol monitors provided that the gravimetric
sampling is conducted in conjunction with real-time sampling [Listak et al. 2007; Thorpe and

® Mention of any company or product name does not imply endorsement of that product by NIOSH.
" Mention of any company or product name does not imply endorsement of that product by NIOSH.



Walsh 2007]. Whether sampling with active or passive devices, it is recommended to conduct
gravimetric sampling in addition to real-time sampling [Williams and Timko 1984]. Generally,
active real-time datalogging aerosol monitors are preferred because of their ability for optional
particle-size selection and as they may have a provision for gravimetric sampling without having
to use an additional gravimetric sampler.

Photos by NIOSH

Figure 1. Thermo Scientific’s pDR-1000 sampler (left) and pDR-1500 sampler (right).

The EVADE software uses video from the camera used in the dust exposure survey. The
video camera that works best is one that is small enough to be attached to the worker’s hardhat.
Past testing of the EVADE software has been completed using the V.1.O. Point-of-View (POV)?
video camera. This is a small compact video camera where the lens component is attached to the
body of the video camera via a length of cable (Figure 2). This allows the camera body to be
placed in the provided carrying case/pouch and the lens can be attached to the worker’s helmet
which allows viewing of the work activity. Many other compact video cameras are available and
can be used as long as the video file is compatible with EVADE. The video file that EVADE can
read is the digital video file which has an avi filename extension. It can also read a wmv file.
Because high-definition (HD) video is becoming more prevalent, EVADE has been modified to
accept MPEG-4 (mp4) video files. Any video camera can be used with EVADE as long as the
output is avi, wmv, or mp4. The EVADE software is currently not compatible with mov files.

& Mention of any company or product name does not imply endorsement of that product by NIOSH.
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Figure 2. The V.1.O. Point-of-View video camera used in the Helmet-CAM, showing the body of the
camera and the lens component (below the body) attached by cable.

It is assumed that the user is familiar with the video recording and dust sampling instruments
being used during the respirable dust personal sampling procedure, called a Helmet-CAM survey.
The user should refer to each device’s operating manual to properly set up the device for sampling.

Sampling Procedure

The data collection using the Helmet-CAM consists of a combination of respirable dust
personal sampling and a video recording performed simultaneously while the worker performs
their regular duties. The data can then be analyzed to determine the sources of respirable dust
exposure to the workers who are engaged in different job occupations.

Using the pDR-1500 for respirable dust sampling allows for logging of real-time dust
concentrations at user-specified intervals and can simultaneously accomplish gravimetric
sampling with its built-in gravimetric filter [Reed et al. 2012]. Other real-time datalogging
aerosol monitors may require a separate gravimetric sampler operating simultaneously. The
gravimetric filter allows for correction or calibration of the real-time concentrations from the
real-time datalogging aerosol monitor to the type of dust being sampled.

Correction or calibration is recommended for all light-scattering instruments [ Williams and
Timko 1984]. The sampling time period of the gravimetric and light-scattering instrument must
be similar. The calibration ratio is calculated using the following equation:

Grav

Ratio =
Instant

where Ratio = the calibration ratio;
Grav = the gravimetric time-weighted average (TWA) concentration; and

Instant = the real-time optical TWA concentration from the 1500-pDR.



Next, the calibration ratio is multiplied by each real-time optical concentration recorded by
the real-time datalogging aerosol monitor in order to obtain absolute concentrations which can be
comparable to other similarly quantified concentrations of other occupations from other real-time
datalogging aerosol monitors.

The pDR-1500 also allows size-selective sampling with D5 cut points ranging from 1 to 12
um using an ACGIH convention using optional cyclones that have been developed for this
monitor [Lippmann 1995]. The D5, represents the median diameter of the particle-size range
being sampled. Other size-selective components (e.g., 10-mm Dorr-Oliver nylon cyclone,
Higgins-Dewell cyclone) may also be used instead of these optional cyclones [Reed et al. 2012].
For example, to sample the respirable size range, the 10-mm Dorr-Oliver nylon cyclone, which
has a Dsp of 3.5 pum at 1.7 L/min flowrate (2.0 L/min for coal), is a possible cyclone that might
be selected [Bartley et al. 1994].

The pDR-1000 or the AM-510 can be used as a sampling device, but an additional
gravimetric sampler with a respirable dust preseparator would be recommended to allow for
calibration, as the pDR-1000 and the AM-510 have no built-in capability for gravimetric
sampling. However, gravimetric sampling may not be required as long as the user understands
the limitation of the resulting data—that the resulting concentrations will be relative
concentrations, not concentrations that are representative of the true mass [ Williams and Timko
1984]. These resulting concentrations would not be comparable with the different occupational
results from other real-time datalogging aerosol monitors.

Respirable Dust Sampling

The following are some helpful suggestions for setting the real-time datalogging aerosol
monitor for respirable dust sampling:

e Use new batteries for each new sampling period.
e Zero the real-time datalogging aerosol monitor prior to each use.

e Set the logging period for 1 or 2 seconds. Longer logging periods are more difficult to
analyze with EVADE as longer time periods make it difficult for the user to identify
exposure sources.

e Set a calibrated flowrate appropriate for the particle-size range desired. Refer to the
operation manual for flowrate adjustment and calibration. Typically, a Dorr-Oliver 10-
mm cyclone is used for respirable dust measurements, requiring a 1.7 L/min flowrate at
metal/nonmetal mine sites (2.0 L/min flowrate for coal mine sites). There is no flowrate
for the pDR-1000, but the gravimetric sampler’s pump flowrate should be set to match
the size-selective preseparator used.

e Disable any alarms. They are not needed.

e Set units to “Mass (ug/m’)” for the pDR-1500 or mg/m’ for other monitors. NOTE: The
unit ug/m’ is equivalent to pg/m’.

e Synchronize the real-time datalogging aerosol monitor and video camera to the exact
time on the devices before testing. This is best accomplished using the time setting on the
download computer.



e Use an appropriate filter. The SKC 5-micron 37-mm polyvinylchloride filter” has been
used effectively for collecting the respirable dust sample with the pDR-1500. Other filters
may be available; the important specifications are the 37-mm diameter and material type.
This filter should be placed in the white filter holders with the stainless steel backing
included with the pDR-1500. Store preweighed filters in a petri dish. Care should be
taken when changing filters to avoid contamination of the filter [Reed et al. 2012].

To conduct respirable dust sampling with the pDR-1500 or AM-510, a Dorr-Oliver 10-mm
cyclone (illustrated in Figure 3) or other size-selective preseparator should be attached to the
inlet. This can be accomplished by attaching the cyclone to the pDR inlet with a 3-ft length of a
nonelectrostatic tubing such as black conductive tubing (other silicone based tubing can be
substituted). The cyclone is attached to the worker’s lapel with the real-time datalogging aerosol
monitor’s body secured to the worker’s belt (Figure 3). The use of a suspension rig belt, safety
vest, or backpack facilitates this setup. Once the dust sampler is set up, the video camera can be
outfitted. Using the video camera, the recording unit can be placed in a pocket of the vest (shown
in Figure 3) or attached to a belt, and the lens is attached to the helmet of the worker using a
typical helmet flashlight mount (Figure 4).

f

Cyclone
Video camera

(in pouch)

Dust monitor

Photos by NIOSH

Figure 3. Setup of sampling devices for personal sampling.

° Mention of any company or product name does not imply endorsement of that product by NIOSH.
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Figure 4. Placement of the video camera lens on the helmet.

If the respirable dust personal sampling is conducted in an operator’s cab, an alternative
setup can be used. A cab setup maintains the use of the real-time datalogging aerosol monitor
and the video device, but the devices are located in an out-of-the-way place in the cab rather than
placed upon a worker (Figure 5). In this case the cyclone is located on the wall of the cab at the
operator’s breathing level. And the video camera lens is placed in an upper corner of the cab
oriented to a position that provides a good view of the operator’s work.

Video camera
lens

Cyclone

Dust monitor

Video camera
body

Photo by NIOSH

Figure 5. Typical setup of sampling and video devices in an operator's cab.



Video camera setup

The following are some helpful suggestions for setting up the video camera when conducting
respirable dust sampling:

Use new batteries for each sampling period. The V.I1.O. POV video camera’s recording
length may be 3—4 hours with alkaline batteries and 6—8 hours with lithium batteries.
Other cameras’ recording length may only be up to 2 hours. Batteries should not be
reused because video recording stops soon after due to low battery power.

Select a low-video-quality setting in the video camera setup menu. High-video-quality
video files become very large (approximately 3 GB for 3 hours) and cumbersome when
saving and copying. There is no observable visual loss of picture detail using low-quality
video when video is played back on the computer. NOTE: The avi or wmv video files
can be approximately 1.8 gigabytes (GB) for 3’2 hours on low resolution. HD video files
(mp4) are even larger.

Set frame rate as low as possible (i.e., 15 frames per second) in the video camera setup
menu.

Sound should normally be turned off in the video camera’s setup menu. However, some
operations may want to use sound to identify workplace surroundings.

Set time to computer time to synchronize time with the pDR.

Use SD (secure digital) memory cards with a minimum rating of Class 6. The class rating
of SD cards refers to the read/write speed of the memory card. A card with a rating of
Class 10 is best as it has a faster read/write speed than a Class 6 card. Using a card with a
rating less than Class 6 will result in dropped frames in the video, making those parts of
the video ineffective for dust exposure analysis.

Once the real-time datalogging aerosol monitor and video camera are in place upon the
worker or in the cab, the devices’ serial numbers or labels should be documented to allow for
identification of the data files when conducting the dust exposure analysis (the easiest method is
to label each device with a number and use those numbers for documentation). The real-time
datalogging aerosol monitor and video camera are started at the exact same time, and the worker
is left to accomplish assigned duties.

Important: Start the real-time datalogging aerosol monitor and the video
camera at the exact same time.

If the real-time datalogging aerosol monitor’s internal clock loses its timing, which has
occurred in past studies due to setting the initial time wrong or from the internal batteries being
depleted, the files can still be analyzed together because both the dust concentration data file and
the video file have the same start times.



Dust Exposure Analysis Setup

After the respirable dust and video sampling has been completed, the user must download the
data files from each device. These data files will be used for analyzing the dust exposure of the
worker that was sampled. If gravimetric sampling was conducted simultaneously during the
survey either by use of the pDR-1500 or by other gravimetric methods, the filter should be
collected and post-weighed to obtain a gravimetric respirable dust concentration. A discussion of
gravimetric sampling is not provided as it is presumed that the user understands gravimetric
sampling procedures.

The pDR-1000, pDR-1500, and AM-510 allow downloading of the files to a computer. To
download the data, the user would use the software program provided by the manufacturer of the
real-time datalogging aerosol monitor. The data should be in comma separated values (csv)
format in order to be used by EVADE.

The video camera generally allows downloading of the files to a computer. The user can use
the software program provided by the camera manufacturer to download the data, or typically,
Windows Explorer can be used to open the directory of the device and copy the file directly from
the device to the computer. The user will copy the video files from the video camera device,
using either avi or mp4 files depending upon the device. There may be a thumbnail file (thm)
located on the video camera device. It is not important to copy this file as EVADE does not use it
during operation.

It should be noted that the avi (or mp4) file may be very large which may result in long
download times (>15 minutes, dependent upon computer speed). Because these video files may
be very large (> 1GB), it is recommended that the user have a large external hard drive to store
the data files. However, when using EVADE, the user would want to copy any files for
investigation from the external hard drive to a working directory on the main drive in the
computer.

For organizational purposes, it is important to save the dust concentration data file and the
video camera file to a common directory. For example, if you are downloading the data files
from sampling a mechanic, all the csv and avi (or mp4) files could be saved to a directory labeled
\mechanic). If the mechanic occupation was sampled at several different sites, the directories
should indicate this. For example, \Minesite #1\mechanic\ would contain all the data files from
sampling a mechanic at Minesite #1. Also, a naming convention for the data files should be
adopted by the user to help describe and organize the csv and avi (or mp4) files.

Once the data files have been saved, the dust exposure analysis using EVADE can be
conducted. The instructions for using the EVADE software are provided in Appendix A and will
allow the user to use EVADE to conduct a dust exposure analysis.
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An Example: Conducting a New Dust Exposure Analysis

The EVADE software program is used to determine sources of overexposure to respirable
dust. Once all of the different worker occupation video and dust concentration data files are
downloaded and placed in their respective directories, the EVADE project analysis can be set up
for viewing and subsequent evaluation. The following are guidelines for conducting a dust
exposure analysis. The EVADE software instructions in Appendix A allow you to use EVADE
which is an important tool for conducting the analysis. Each mine site’s needs are different, and
you may use a methodology that may differ from these guidelines, but satisfy the needs of your
site.

Once the user has the dust concentration data for each occupation, the overall time-weighted
average (TWA) dust concentration should be recorded and ranked for each occupation. Dust
exposure analysis should be conducted, first, on occupations which have the higher TWA dust
concentrations. The user can determine if an occupation’s ranking will be based on gravimetric
sampling or on real-time sampling. If filters were used to obtain a gravimetric sample, they
should be sent for silica analysis, although it is not required. The silica analysis would aid in
determining source exposure for respirable silica dust.

Documenting the overall TWA dust concentration will aid the user in determining the overall
exposure for each occupation and determining the order of analysis based upon ranking of
concentrations. Table 1 shows an example of documenting TWA concentrations for each
occupation from a Helmet-CAM survey conducted on a blast crew at a surface mine site.

Table 1. Dust concentrations from Helmet-CAM study of blast crew

Job Grav1metr_1c PDR . Calibration .Samplln.g %
Descrintion Concentration Concentration Ratio Time Period Quartz
P (mg/m°) (mg/m°) (minutes)
Blaster 2 0.179 0.235 0.761 193 11
Stemmer 0.101 0.051 1.971 189 12
Blaster 1 0.079 0.108 0.661 182 26

In some cases the TWA dust concentrations may be very low. However, this does not
preclude the existence of spikes of high respirable dust concentrations during the sampling
period. These spikes will be the targets that the user exploits for source determination.

The user then sets up a new dust exposure analysis for an occupation through the File menu
in the EVADE program after which the analysis is ready to commence. At this point, the main
program window shows the video display and the dust concentration graph (Figure 6).
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Figure 6. The EVADE main window after either the New Project or Open command under the
File menu are selected to set up a new dust exposure analysis.

An initial step after setting up an EVADE occupation analysis, is to create thresholds that will
aid the user in source identification. These thresholds may be the legal limit for respirable dust or
may be some other user-defined limit. The number of thresholds to use can be determined by the
user. The threshold(s) can be used as a guide to show dust concentrations that are of concern.

If the Helmet-CAM surveys were conducted in conjunction with gravimetric samplers, the
calibration ratio should be used to adjust the dust concentrations from the light-scattering dust
sampling instruments. The use of the calibration ratio will allow for comparison of dust
concentrations across all occupations to help determine which occupations are more susceptible
to respirable dust overexposure.

The user then proceeds viewing the playback of the video and dust concentration graph. The
user can first target the highest spikes in respirable dust concentrations, which generally
represent a specific activity being conducted by the occupation. EVADE automatically
bookmarks the five highest concentration spikes. The software uses an algorithm that allows it to
identify separate peaks, while attempting to prevent clustering of the five bookmarks around a
single peak. The user can proceed to these bookmarks to identify the exposure sources through
the video. The user can then proceed to other additional peaks creating additional bookmarks to
identify other sources from occupation activities by bookmarking them in EVADE.

Selecting the Export Bookmarks command (from the File menu) and the Screenshot
command (from the View menu) will allow the user to document the sources of respirable dust
overexposure for the occupation. The Export Bookmarks command will save the bookmarks as a
csv file which can be imported into a spreadsheet, allowing the bookmarks to be edited to create
tables. Table 2 is an example of a table created using data from the Export Bookmarks command
that documents potential respirable dust exposure sources. The Screenshot command exports the
current view of the EVADE software to a jpg file which can also be used to document potential
respirable dust exposure sources.

12



Table 2. EVADE automatic and user-defined bookmarks showing times, concentrations,
and job activities for Blaster 1

Bookmark Bookmark Time' Concentration -
# Type (hh:mm:ss) (mg/m®) Job Activity
1 Automatic 01:16:30 5.620 Loading hole w/ANFO?
2 Automatic 01:05:18 2.054 Loading hole w/detonator
3 Automatic 01:19:22 1.974 Loading hole w/ ANFO
4 Automatic 01:05:22 1.968 Loading hole w/detonator
5 Automatic 01:27:56 1.948 Cleaning hardhat
6 User-defined 00:25:09 1.836 Loading hole w/ANFO
7 User-defined ~ 00:08:38 0.581 I;;ﬁﬁ‘;gdgﬁlr;al downhole for
8 User-defined ~ 00:11:05 0.632 I;;ﬁﬁ‘;gdiﬁf;l downhole for
9 User-defined 00:29:02 0.791 Loading hole w/ANFO
10 User-defined 00:31:28 0.947 Loading hole w/ANFO
11 User-defined  02:52:44 1754 paciang ANFO truck out of
12 User-defined 01:20:37 1.658 Loading hole w/ANFO
13 User-defined 01:21:52 1.551 Loading hole w/ANFO
14 User-defined 01:18:20 1.698 Loading hole w/ANFO
15 User-defined 01:26:14 0.713 Stemming w/foot
16 User-defined 01:38:15 0.414 Drop explosive box in dust
17 User-defined 01:28:41 0.625 Clean hardhat
18 User-defined 00:43:12 0.808 Load hole w/ANFO

"Time represents elapsed time of the video where bookmark occurs.
?ANFO —Ammonium nitrate and fuel oil.

The number of bookmarks to create identifying respirable dust exposure sources is dependent
upon the user’s needs. Once sources are identified, engineering controls or work behaviors can
be developed or modified to eliminate exposure from the source. EVADE will help in the
development of these controls or behaviors by allowing the user to view the source of exposure
by allowing repeat or pause of the video as many times as desired.

EVADE can also be used as a training tool to show workers the sources of their overexposure
to respirable dust. Playback of the EVADE program can be conducted with the worker to
highlight areas where overexposures occurred while daily tasks were performed. The video can
demonstrate what duties the worker was performing while the dust concentration data shows the

13



levels of respirable dust to which the miner was exposed. Additionally, EVADE can also be used
in a safety meeting setting to show exposure sources to the entire work crew. It is recommended
that you, as the user of this software program, review the video and data files prior to presenting
the information at a safety meeting. As you gain experience working with the software, you may
find additional novel techniques for finding respirable dust exposure sources for different mining
occupations. Additionally, you may find other beneficial uses for the EVADE software.
Ultimately, you and other users of the software will find that EVADE is an important tool in
preventing respirable dust exposures in the mining industry.
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Appendix A

Instructions for Using the EVADE Software Version 1.0

Installing the EVADE Software Program

The files required for the installation of EVADE are located on the enclosed CD or can be
downloaded from the NIOSH OMSHR website. An Installation Wizard will allow you to easily
install EVADE on your computer. After installing EVADE, a video codec may have to be
installed to view the video files if the video does not playback. If codec installation is required,

follow the instructions in the Installing the Video Codec section in this document.

NOTE: Administrative rights may be required to install the software.

To install the EVADE software, perform the following steps:

1.

Insert the EVADE software CD into your computer’s CD drive or download the software
from the EVADE website.

Start Windows Explorer to browse the contents of the CD.

Double-click on the Setup.exe icon: [ o

The .NET framework is required for EVADE. If it is not already installed, the setup
program will automatically install it. A dialog box will appear for NET framework
installation and should proceed without requiring user intervention.

The initial installation window appears (Figure 7). This is the Setup Wizard which will
guide you through the installation process.

EVADE - InstallShield Wizard [

‘Welcome to the InstallShield Wizard for EVADE

The InstallShield Yizard will install EVADE on your
computer. To continue, click Nest.

Figure 7. The initial installation window for EVADE.

5. Once this installation window appears, click Next.

6. A window with the Disclaimer of Liability Clause will appear for you to read (Figure 8).
(The text of the Disclaimer is shown in italics below Figure 8).
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If you agree with the Disclaimer, check the I have read and accept this disclaimer
selection, and click Next to proceed. A print option is available if you want to print out
the Disclaimer text.

EVADE - InstallShield Wizard =)

Disclaimer of Liability

Please read the following disclaimer carefully, |\' P

Disclaimer of Liability Clause

This NIOSH/OMSHR developed software is provided "AS IS" without |=
warranty of any kind including express or implied warranties of
merchantability or fitness for a particular purpose. By acceptance

and use of this software, which is conveyed to the user without
consideration by NIOSH, the user expressly waives any and all claims
for damage and/or suits for personal injury or property damage

() 1 have read and accept this disclaimer

@ | do not accept this disclaimer

Figure 8. Window displaying NIOSH Disclaimer.

Disclaimer of Liability

This NIOSH/OMSHR developed software is provided “AS IS without warranty of any
kind including express or implied warranties of merchantability or fitness for a particular
purpose. By acceptance and use of this software, which is conveyed to the user without
consideration by NIOSH, the user expressly waives any and all claims for damage and
/or suits for personal injury or property damage resulting from any direct, indirect,
incidental special or consequential damages, or damages for loss of profits, revenue,

data or property use, incurred by the user or any third party, whether in an action in
contract or tort, arising from access to, or use of, this software in whole or in part.

No further development or upgrades for this software is planned. Any questions
concerning this product can be directed to the Office of Mine Safety and Health Research
email box at <mail to:OMSHR@cdc.gov>

The wizard will display the folder where EVADE will be installed (Figure 9). If this
directory is satisfactory, click Next to proceed.

EVADE - InstaliShield Wizard ==
Choose Destination Location ‘
Select fokder where setup villinstal files I\ -
Istal EMADE to
C:\Program Files (+85)\NIDSHAEVADE

[ <Back | New> | [ cancel |

Figure 9. Window displaying folder where EVADE will be installed.

If you prefer a different directory, click Change to open another window which will
allow you to select the folder where you want EVADE to be installed (Figure 10).
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o

Please select the installation folder.
Path:

Ci\Program Files (x36)\NIOSH\EVADE
Directories:

b | Lbrivelnfo
b k. MsOCache L
4 ) nosk BN | >l
| EVADE
). 0ld Laptop files. ion Location
J. pORCOM re setup will install files.
b ). Perflogs —
« i §
EVADE to:
gram Files (6)\NIOSH\EVADE Change.
oo

[ <Back [ nNet> | [ cancel ]

Figure 10. Window displaying dialog box where you select the installation folder.

Using this window, you can either type the desired installation folder or select the desired
installation folder. Click Next after making the desired selection.

The next window notifies you that the program is ready for installation (Figure 11).

Ready to Install the Program
The wizard is ready to begin installation

Click Imstall t begin the installation

IF pau want ta review or change any of your instaliation setings, click Back. Click Cancel ta et
the wizard.

[ <Back || nstal | [ Cancel |

Figure 11. Confirm installation window.

Click Install to proceed with the installation. As the installation proceeds, a window is
displayed which contains a bar showing the progress of the installation (Figure 12).

Setup Status

The InstallShield Wizard is instaling EWADE

Instaling

C:APragram Files (+85I\MIDSHAEVADEAEVADE _Start_Demal.avi

Cancel

Figure 12. Installation progress window.
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10. Once the installation is complete, a window will appear notifying you that the installation
was successful (Figure 13). A check box is automatically selected to create an EVADE
shortcut on the desktop. Deselect the check box if you do not want a shortcut created on
the desktop.

InstallShield Wizard Complete

The Install$hield wizard has successfully installed EVADE.
Click Finish to exit the wizard,

Crsate 3 shortcut on the desktop

| cBack [ Finsh | | Concel |

Figure 13. Installation complete window.

11. Click Finish to exit the installation wizard.

12. The EVADE program is ready for use. An EVADE icon [ ’ ] is optionally placed on

EwADE
the Windows desktop, enabling you to easily start the program.

13. EVADE can also be started from the Start menu by selecting All
Programs/NIOSH/EVADE and then selecting EVADE (Figure 14).

B evaoe =R
Fie Bookmarks Playback View Help

[ i e |

Reading: 0000

Figure 14. The Start menu showing the location of the EVADE software, User’s Manual,
Quick Start Guide, and EVADE Demo Video.
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Clicking EVADE starts the EVADE software. While clicking the EVADE User’s
Manual and EVADE Quick Start Guide, open each file in Adobe Acrobat reader,
respectively.

Also included is an EVADE Demo Video (without sound) that can be viewed and which
presents to the user (by following the mouse cursor) the basic operation and playback
features of EVADE. This video is started by clicking the EVADE Demo Video.

An example video file and respirable dust concentration data file are available for testing
the EVADE software. They are included on the CD in the \ExampleData\ directory or are
available from the EVADE website.

Removing the EVADE Software Program

If you want to remove EVADE from your computer, there are two methods to accomplish this
task:

e One method is to proceed to the Window’s Control Panel and select the command which
enables you to uninstall, change, or repair software programs. Click on EVADE in the
list of programs to remove the EVADE software from the computer.

e The other method is to use EVADE’s software removal tool. This is accomplished by
reinserting the CD and double-clicking the Setup.exe icon on the CD. The setup wizard
will automatically detect if EVADE is on the computer and provide three options:
Modity, Repair, or Remove. The Remove option will remove the EVADE software from
the computer. Select the Remove all installed features option and click Next to
complete the removal of the EVADE software from your computer (Figure 15).

EVADE - InstallShield Wizard -
Welcome q;
Modity. repair o remove the prograrm I .

Welcome to the EVADE Setup Maintenance program. This pragrarm lets you mocify the current
installafion. Click ane of the apiians below.

© Modiy

A Select new program festures to add or select currently installed featurss to
BE emoe

Fepair
ﬁ Reinstall all program features installed by the previous setup.
]

Remave

ﬂ Remove all installed features.
e

<Back Cancel

Figure 15. Window showing the Modify, Repair, and Remove options for EVADE.

Repairing the EVADE Software Program

The Repair option (Figure 15) is used if you encounter problems operating EVADE; this option
will complete a re-installation in an attempt to repair the program.

Modifying the EVADE Software Program

The Modify option is currently not enabled. This option would normally be used to install or
remove program features. This feature will be used in future program updates.
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Installing the Video Codec

To view the video files in EVADE, you will also have to install the DIVX codec on your
computer. This codec can be found on the installation disk provided by V.1.O. for the POV
cameras, or can be downloaded and installed from the DIVX website:
http://www.divx.com/en/software/divx-plus/codec-pack. Follow the instructions listed on the
website to use this codec.

Another codec which seems to work better with EVADE, providing better video playback, is the
XVID codec, which can be downloaded from the website: http://www.xvid.org.

Overview of the EVADE Main Window

To start the EVADE program:

1. Double-click on the EVADE shortcut icon [ !] located on the Windows Desktop or go
VAaD
to the Start menu and select All Programs/NIOSH/EVADE and select the EVADE icon.
2. EVADE will start by displaying the main window of the program (Figure 16).

The window may open in a minimized mode. You can change the default window size.
Upon opening the program, change the window to the desired size. Exit EVADE and then
restart. EVADE will remember the last window size display and use it for the default size
on the next startup.

Video display area

‘ Zoom: Optians

@ 000 :H

Reading: 0.000

Figure 16. The main window of the EVADE program.
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The EVADE main window contains the following elements:

e The active title bar at the top of the window contains the name of the software program,
EVADE, on the left and the standard Minimize, Restore Down/Maximize, and Exit
buttons that are familiar with typical windows programs on the right.

e Right below the active title bar is the menu bar, which contains a series of drop-down
menus: File, Bookmarks, Playback, View, and Help. Clicking on any one of these menu
names opens a drop-down menu with commands for operating the program.

e The display areas for the dust exposure analysis consist of two open areas. The large gray
area on the right is the video display area. The large white area underneath the title
Reading: 0.00 is where the dust data graph will display when an analysis through
EVADE is begun.

e On the left below the menu bar are the following menu tabs: Details, Active Bookmarks,
Active Files, and Notes. Clicking on any of these tabs will display different information
in the subwindow just beneath the tabs.

e Below the menu tabs area is a Zoom bar which can be used to zoom in and out on the
dust data graph during analysis.

e Below the Zoom bar are the following action buttons: Open File, New Project, Play,
Pause, Stop, and Audio On/Audio Off (Mute) if audio is used.

Menu Bar Commands

The menu bar consists of the following menus: File, Bookmarks, Playback, View, and Help.
Clicking on each menu name opens a drop-down menu which allows you to set up and operate
the EVADE program for dust exposure analysis. The following sections describe each menu and
its commands.

File Menu

The File menu contains program commands that are used to initiate the dust exposure analysis.
Click on File to open a drop-down menu listing the following commands (shown in Figure 17):

e Open (Ctrl+O)

e New Project (Ctrl+N)

e Export Bookmarks (Ctrl+E)
o Exit

In parenthesis next to each command are the keystrokes that can also be used to start the
command. Once a File command has been used to set up the initial analysis, the commands in
the Bookmarks, Playback, and View menus can be used. The commands in the Help menu can
be used at any time to view Help topics for EVADE.

During the initial use of EVADE for a Helmet-CAM project, you will first select the New
Project command to set up the analysis, defining the proper video and dust concentration data
files to use in the respirable dust exposure analysis. Select the Open command to open existing
analyses where these files are already established.
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At the initial startup of the EVADE software, it will create a directory labeled EVADE in the My
Documents folder of the computer. This EVADE directory will contain data files used by
EVADE for software operation. The default directory location where the program dcf files,
where dcf stands for dust camera file, will be stored will be the user selected directory containing
the video and dust concentration data files. This EVADE directory is the location where dcf files
will be automatically saved, unless otherwise specified. You have the option to select other
directories as needed for the opening and saving of dcf files.

NOTE: Setting up EVADE to use data files from a CD, DVD, or network drive is not
recommended. Because the video files are usually very large, file access errors may occur, and
the EVADE program may not operate correctly during operation. It is best to set up the data files
from your computer’s C:\ drive or any drive that has high speed read/write access.

Reading: 0.000

Ready..

Figure 17. The File drop-down menu displaying available commands.

Open Command
The Open command is used to open an existing dust exposure analysis.
To open an existing analysis:

1. Click on the Open option from the File menu to open the Open dialog box (Figure 18).
This dialog box lists the filenames of existing dust exposure analyses and allows you to
select the existing analysis file you want to open. The analysis file has the naming format
of <filename>.dcf . This file is created during the configuration of an initial analysis
under the New Project command. Therefore, these files will not be available during the
initial setup. There is only one file created for a configured dust exposure analysis. You
can create additional analyses for the same occupation by renaming the dcf file.
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Figure 18. The Open command dialog box.

Find the proper directory where the dust exposure analysis is stored.

Click on the desired filename of the dust exposure analysis you want to open, then click
Open. The EVADE main window will update to display the video in the video display
area and the dust concentration data graph (Figure 19).

B EvaE
File Bookmarks Playback View Help

Detais | Active Bookmarks | Active Fies | Notes |
Date: 10-Aug-2011
Model: PDR-1600
Duration: 03:01:45
Max: 851484
Max @: 09:67:05
Time: 00:00:00

Units: Micrograms

Reading: 18.520
New Bookmark

902,61
1951.3|—+
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Loaded: Blaster 8-10-11 V21.dcf

Figure 19. The EVADE main window after an existing dust exposure analysis is selected
through the Open command.

27



Possible Error Messages When Using the Open Command:

If there are possible problems with the data, a data file information message will be displayed to
inform you of possible errors. Two common types of errors encountered are negative values and
missing values (Figure 20).

Data File Information ﬁ

i Processing the data file caused multiple results:
There were 82 negative values recorded. You should check the
calibration of the PDR-1500 collection unit.

There was 1 instance where the file line contained bad
characters; an averaged value was created/used.

Figure 20. Data file information alert for negative values and missing values.

Negative values may occur due to faulty calibration of the real-time datalogging aerosol monitor.
When encountered, the data is not changed by the program. The negative value alert is aerosol
monitor specific. The alert will identify the real-time datalogging aerosol monitor based upon the
data format encountered, i.e., if the data format is pDR-1500, then the alert mentions pDR-1500;
if the data format is pDR-1000, then the alert mentions pDR-1000; if the data format is AM-510,
then the alert mentions AM-510; and if the data format is EVADE’s universal format, then the
alert mentions the type of real-time datalogging aerosol monitor that was input in the universal
format dialog box. Missing values, another type of error, in the data file are identified as bad
characters by EVADE. If there are missing values, the program substitutes a value that is the
average of the previous and subsequent values surrounding the missing value. However, data in
the dust concentration data file are not changed.

Another possible error that can occur is when the video and dust concentration time lengths are
offset (Figure 21). A data file information alert informs the user that there is a difference
between the length of time of the video file and of the dust concentration file. The program
notifies the user of the time differential, but does not adjust for it.

NOTE: It is very important to start the real-time datalogging aerosol monitor and the video
camera at the same time. EVADE cannot detect nor correct for any time differential due to
differing startup times.
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Data File Information i

i Processing the data file caused this result:
The time indicated by the data file and the video's time were off

by 1462 seconds. The data file was longer. Maximum bookmarks
may not work correctly.

Figure 21. Data file information alert for time differential between video and
dust concentration files.

Clicking OK in any of the data file information boxes will clear the alerts. Once the window
updates, the EVADE program will allow you to proceed with the dust exposure analysis. These
data file information dialog boxes are informational windows only, and do not initiate
corrections to be made by EVADE. To correct these errors, the user must physically edit the data
files. As long as the video and dust sampling devices were started simultaneously and there is not
a large number of negative values, editing the data files is not required and the dust exposure
analysis can be conducted without any adverse impact from these errors.

There is the possibility that the video file may be corrupt due to disk read/write errors, multiple
copying, etc., causing the video to not display in EVADE. In this case, a Video Load Error! will
occur notifying you that the file is corrupt (Figure 22). EVADE will ask if you want to delete the
dcf file to prevent the corrupt video file from being used in any dust exposure analysis. It is
generally recommended to delete the dcf file and restart the dust exposure analysis anew.
However, if a backup of the video file is available, the backup video file can be copied over the
corrupt video file which should correct the Video Load Error. In this case, you would want to
select No to deleting the dcf file when the Video Load Error! dialog box appears.

Video Load Error! &J

I, Thevideo file seems to be corrupt. A DCF file was not created.

Figure 22. A Video Load Error! dialog box that appears during the Open command
if the video file is corrupt.

New Project Command

The New Project command is used to create a new dust exposure analysis. The data files that are
used by EVADE are as follows:

<filename>.csv  Dust concentration data file. Created by the pDR-1000, pDR-1500, or
AM-510.

<filename>.avi A standard definition video file.

29



<filename>.mp4 A high definition video file. Currently, only Microsoft video formats are
supported by EVADE. The software program will not work with Apple
video formats.

<filename>.wmv A Windows media video file. This format can also be read by EVADE. If
problems viewing the avi video file occur during operation of EVADE, the
video file can be converted to the wmyv format.

<filename>.bmk EVADE bookmark file. Created by EVADE during previous review of
dust concentration and video files. This file contains the bookmarks
automatically created by EVADE and any user-defined bookmarks.

These files are downloaded from the real-time datalogging aerosol monitor and video camera
and should be placed in a common directory where they can be selected by EVADE. It should be
noted that the bookmark file is created after the initial dust exposure analysis setup of the data
files using EVADE. It will not be available during the initial setup of the analysis.

The user should ensure that the video (avi, mp4, or wmv) and dust concentration data (csv) files
are located in the same directory because EVADE will not allow the setup procedure if only one
type of file is in the directory. Additionally, once bookmark files have been created, the user
should ensure that they are located in the same directory with the avi and csv data files in order
to access the bookmarks during later dust exposure analysis.
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To start a new dust exposure analysis:

1.

Click on the New Project option from the File menu to open the Create New EVADE
Project dialog box which is used to locate and associate the video, datalog, and
bookmark files required to conduct a new dust exposure analysis (Figure 23). This dialog
box contains three selection buttons, Select video file..., Select datalog file..., and
(Optional) Select bookmark file..., each of which prompts the user for a specific action.
The user is guided through the selection process via highlighted selection buttons. For
example, in Figure 23 the user is prompted to select a video file, which is the first step.
Clicking Cancel terminates the Create New EVADE Project process.

{8 Create New EVADE Project

...

‘ Zoom:

v Jo oo

Reading: 0.000

Paused:

Figure 23. The Create New EVADE Project dialog box which opens when the New Project
command is selected from the File menu.
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Click the Select video file..., the first highlighted selection button, to launch an Open
dialog box (Figure 24). This dialog box allows selection of the video files in avi, mp4, or
wmy format. The location of these video files can be selected by scrolling through the file
listing on the left side of the dialog box and selecting the desired directory. The data can
be located in a directory on any drive: for example, C:\ drive, CD rom drive, network
drive, etc. It should be noted that poor video playback may occur in the EVADE software
when the data is located on a network drive. EVADE will provide a notification of this
circumstance (Figure 25); click OK to clear the message. Once the video file is selected,
click Open to proceed. The next step Select datalog file will be highlighted. Selecting
Cancel terminates the Select video file process and returns the user to the beginning of
the Create New EVADE Project procedure.

B Create New EVADE Project A =I) | = x|

1. Select video file...

). » Computer » Local Disk (C) » HelmetCAM » Blaster

janize ~  New folder

J. HelmetCAM “  Name Date Type Size Length

| 8 Biasters-10-12.4v1  8/10/2011 11:42 AM Video Clip 1302,767... 030145
E]

). Pit Utility

). PitMechanic

Max @: ). PlantDustin

). PlantScott

). RubberTired Dozer

| ShovelMech - )

File name: Blaster 8-10-1LAVI

o i

¥[Ue0o0&

Reading: 0.000

Figure 24. The New Project command dialog box showing drive directories.

|

A

Warning: Running EVADE using a network share may result in
“~  poorvideo playback.

Figure 25. The warning message notifying the user that EVADE video playback may be
unsatisfactory when running data files from a network drive.
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Click the Select datalog file... button to open the Select Datalog (CSV) File dialog box
(Figure 26). This dialog box allows selection of the dust concentration data to be used by
EVADE. The available dust concentration files, in csv format, are listed in this dialog
box. Once the proper csv file is selected, click Select to proceed. Selecting Cancel
terminates the Select datalog file procedure. The next step (Optional) Select bookmark
file will be highlighted.

NOTE: This dialog box does not allow for switching directories. It uses the directory
chosen during the video selection process. Therefore, it is important to keep all video and
dust concentration data files in the same directory.

8 Create New EVADE Project == %] = b
1. Select video fle.. C\HelmetCAM\Blaster\Blaster 8-10-1LAVI
2. Select datalog file.. | Not set.
{8 select Datalog (CSV) File
=  bookmark ie.. | Notse.
[Name [Crested Size
(E)Biaster) Unit28_10_11.csv_ 12/18/20132:21:41PM 387780 bytes
EPEETAIVIPIRREEN 12/18201322141PM 387760 byles
Max:
Max @:
Tim
Units:
[zoem

v Jooeow

Reading: 0.000

Paused:

Figure 26. The Select Datalog (CSV) File dialog box allowing selection of the
dust concentration data file.
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4. Click the (Optional) Select bookmark file... button to open the Select Bookmark
(BMK) File dialog box (Figure 27). This dialog box allows selection of the bookmark
file. A bookmark file, a filename with a bmk extension, is a file that contains bookmarks
from a previously conducted dust exposure analysis. The initial project setup may not
have an available bookmark file. Therefore, this is an optional command and selecting
this command may not be required if there is no bookmark file or if the user decides not
to use any existing bookmark files. As with the Select Datalog file step, this dialog box
does not allow for switching directories. It uses the directory chosen during the video
selection process. Click Select to proceed. Selecting Cancel terminates the Select
bookmark file procedure.

B Create New EVADE Project = =] % ) =18 % |
1. Select video file... (C:\HelmetCAM\Blaster\Blaster 8-10-11.AVI
CAHelmetCAM\Blaster\e8laster) Unit 2 810_11 - Copy.csv

{8 select Bookmark (BMK) File:

¥U0 00

Paused:

Figure 27. The (Optional) Select Bookmark (BMK) File dialog box allowing selection
of a bookmark file.
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Once these steps are completed, the Create Project button becomes highlighted (Figure
28). At this time, if you notice a mistake in selecting a data file, you can go to any of the
previous steps, (Optional) Select bookmark file, Select datalog file, or Select video
file, and click on the appropriate button to reselect the data file.

NOTE: Selecting Select video file will start the entire file selection process over. Click
on Create Project to proceed.

8 Create New EVADE Project

1. Select video file... C:\HelmetCAM\Blaster\Blaster 8-10-11.AVI
2. Select datalog file... C:\HelmetCAM\Blaster\eBlaster) Unit 2 810_11 - Copy.csv

[t~ (o]

¥ Ue ook

Reading: 0.000

Paused:

Figure 28. The Create New EVADE Project dialog box after all data file selections
have been completed.
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6. After selecting Create Project, a Save As dialog box will open allowing you to save the
project (Figure 29). NOTE: To prevent overwriting the dcf files, the filename will be
changed to <filename vI>.dcf. With subsequent saves, v/ will automatically increase as
follows: viI, v2, v3,etc. The user always has the option to rename the file. Once Save
is selected, the window will update to display the video and dust concentration graph in
the EVADE main window. Once the window updates, the EVADE program is ready to
be used to conduct the dust exposure analysis.

B Create New EVADE Project NEINF) | = =
C\HelmetCAM\Blaster\Blaster 8-10-11.AVI
2. Select datalog file... C:\HelmetCAM\Blaster\eBlaster) Unit 2 810 11 - Copy.csv
« ) C:\HelmetC/ 8-10-11.bmk.

Create Project Cancel

| » Computer » Local Disk (C) » HelmetCAM » Blaster

rganize > New folder

). HelmetCAM

4 Name Date

| Blaster

9 Blaster8-10-11dcf  12/13/2013 906 AM DCF File 1ke
| BlasterHelper

] Blaster 8-10-11 V1. 12/12/2013 9:12 AM DCF File 1ke

. BlasterSkidSteer
= 9 Blaster 8-10-11.V28.. 6/7/2013 954 AM DCF File K8
). Grader =

). luber
). Pit Utility
| PitMechanic

J. PlantDustin
b P

-«
Blaster 8-10-11. V2.4 -

Save as type: |dcf fles (dcf)

File name:

 Hide Folders

Reading: 0.000

Figure 29. The Save As dialog box displayed after selecting Create Project.

Possible Error Messages When Using the New Project Command:

As with the Open command, when using the New Project command data file information
messages may display to inform the user of possible problems with the data. Two types of errors
commonly encountered are negative values and missing values (Figure 20). If negative values
occur, a data file information message will be displayed to alert you to their presence. When
negative values are encountered due to faulty calibration of the real-time datalogging aerosol
monitor, the data is not changed by the program.

If there are missing values, you are alerted with a data file information message and the program
substitutes a value that is the average of the previous and subsequent value surrounding the
missing value. However, data in the dust concentration data file are not changed.

Another possible type of error that can occur is that the video and dust concentration time
lengths are offset (Figure 21). A data file information alert informs you that there is a difference
between the length of time of the video file and of the dust concentration file. The program
notifies you of the time differential, but does not adjust for it. NOTE: It is very important to start
the real-time datalogging aerosol monitor and the video camera at the same time. EVADE cannot
detect nor correct for any time differential due to differing startup times.
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Click the OK button in the dialog boxes to clear the data file information alerts. Once the
window updates, the EVADE program will allow you to proceed with the dust exposure analysis.

There is the possibility that the video file may be corrupt due to disk read/write errors, multiple
copying, etc. causing the video to not display in EVADE. In this case, a Video Load Error! will
occur notifying you that the file is corrupt (Figure 30). EVADE will not create a dcf file. Click

“Ok” to clear the error and to start over with the New Project command.

Video Load Error! ﬁ

L. The video file seems to be corrupt. A DCF file was not created.

Figure 30. A Video Load Error! dialog box that appears during the New Project command
if the video file is corrupt.

Export Bookmarks Command

The Export Bookmarks command allows you to export the bookmark information that has been
created during an EVADE analysis. This command allows conversion of the bmk file to a csv file
which can be used in a written report. A bookmark is a link to an individual dust exposure event
during the respirable sampling time period of the Helmet-CAM survey. EVADE creates five
automatic bookmarks at the five highest dust concentration peaks in the data file. You can create
additional bookmarks for other dust exposure events (see the Bookmarks Menu section for
further information).

To export bookmark information:

1. Click on the Export Bookmarks option from the File menu or use the Ctrl+E keystrokes
to display the Save As dialog box for saving the bookmarks (Figure 31). The default
filename will be the name used for the bmk file with the added EXP after the filename,
but before the bmk extension. You have the option to rename the file and place it in a
location of your choice.
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Figure 31. The Save as dialog box for saving the exported bookmark file. This example also shows
the active bookmarks under the Active Bookmarks tab.

2. The exported bookmark file will be saved as a comma delimited file (.csv) which can be
viewed in Excel or WordPad/Notepad. The file will have the following data columns
(which correspond to the information that can be viewed through the Active Bookmarks
tab):

Bookmark #. The number that corresponds to the bookmark number in EVADE.

Name. The user defined name of the bookmark or the label Max 1 through Max 5 if
an automatic bookmark.

Time (hh:mm:ss). The time that the bookmark occurs in the video file.

Concentration (micrograms, milligrams, % concentration, or ppm). The dust
concentration value associated with the bookmark

An example of a typical exported bookmark file is shown in Table 3. The first row is the title
row with the column titles. Each row thereafter corresponds to a bookmark and displays the
columnar information, which corresponds with the Active Bookmark Tab columns, associated
with that bookmark. Name corresponds with Description, and Concentration corresponds with
Reading. The first five data rows will contain information for the five automatic bookmarks,
which will be named Max 1 through Max 5. Time will always be in hh:mm:ss and Concentration
may be micrograms or milligrams, depending on the units selected.
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Table 3. Example of exported bookmark data using the Export Bookmarks command

Bookmark # Name' Time (hh:mm:ss) (u(fl;):lﬁt;?gt:_gnmzs)
1 Max1 01:14:16 4,456
2 Max2 00:33:12 1,992
3 Max3 00:33:20 2,000
4 Max4 01:17:26 4,646
5 Max5 00:33:16 1,996
6 stemming’ 00:17:37 1,057
7 stemming 00:18:35 1,115
8 stemming 00:20:54 1,254
9 stemming 00:21:40 1,300
10 stemming 00:34:33 2,073
11 stemming 00:35:19 2,119
12 stemming 00:48:33 2,913
13 stemming 00:50:40 3,040
14 stemming 00:55:24 3,324
15 stemming 01:00:00 3,600
16 trk rev* 01:20:23 4,823
17 revtrkincab’ 01:20:57 4,857
18 stemming 01:25:16 5,116
19 stemming 01:28:22 5,302
20 stemming 01:31:52 5,512

"Name corresponds with Description on the Active Bookmarks Tab

* Concentration corresponds with Reading on the Active Bookmarks Tab

? stemming refers to the job activity of filling the blasthole with stemming material

* trk rev refers to increasing the truck engine rpm when operating

> revtrkincab refers to backing up the bulk truck while operator is in cab with window open

Exit Command

Clicking the Exit command option from the File menu allows you to exit the EVADE program.

Bookmarks Menu

A bookmark is a link to an individual dust exposure event during the respirable sampling time
period of the Helmet-CAM survey. The Bookmarks menu allows you to add bookmarks as
needed. The added bookmarks are user-defined bookmarks. EVADE creates five automatic
bookmarks at the five highest dust concentration peaks in the data file. The Bookmarks menu
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allows you to turn on and off these five automatic bookmarks created by EVADE. Click on
Bookmarks on the menu bar to open a drop-down menu which contains the following
commands (Figure 32):

Add (Ctrl+B)
On/Off Max Bookmarks

File | Bookmarks | Playback View Help
trl+1

Det:

Date: 10-Aug-2011
Model: PDR-1500
Duration: 03:01:45
Max: 8.51464

Max @: 09:67:05
Time: 00:08:27

Units: Milligrams

Zoom: { | |options.

“Ue/00x

5]

Reading: 0.409

08:a81[08:49:02/9:49:35 __ 08:50:35

Paused: Blaster 8-10-11 V2Ldcf

Figure 32. The Bookmarks drop-down menu (upper left) with available commands.

Add Command

The Add command from the Bookmarks menu allows the creation of bookmarks on the dust
concentration graph. A bookmark can be used to mark a position on the graph to which you can
refer at a later time during the dust exposure analysis. The bookmarks added through the Add
command are user-defined bookmarks.

To add a bookmark:

1.

Do one of the following to select the position on the dust concentration graph where you
want to add the bookmark:

NOTE: The vertical green line on the graph represents the location on the graph that
corresponds to the picture displayed on the video screen.

e Allow the dust concentration graph to move or playback to the desired position
during playback.

e Drag the dust concentration graph to the desired location using the mouse. To do this,
left-click on the graph, then drag the graph in the desired direction.

e Use the slider bar, located right above the graph, to adjust the display of the dust
concentration graph.
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2. Once the vertical green line is at the desired location for the bookmark, click Add from
the File menu or use the keystrokes Ctrl+B. The Add Bookmark dialog box opens
prompting for a bookmark description (Figure 33).

Note: Click Cancel to cancel the operation of creating a bookmark.
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Figure 33. The Add Bookmark dialog box.

3. Enter a name for the new bookmark in the Description box (12-character maximum) to
identify the bookmark. Then, click OK to set the bookmark.

For example, typing a description such as “New Bookmark” in the Description box and
clicking OK will add a new bookmark at the location of the vertical green line (Figure 34)
and label that location “New Bookmark.” It will also number the bookmark with the next
consecutive number (shown as Bookmark # 6 in the Active Bookmarks tab in Figure 34).

The program automatically marks 5 bookmarks for the first five highest dust
concentrations from the dust concentration data file. The program allows a maximum of
50 bookmarks per dust exposure analysis.

4. In addition to automatically numbering the bookmark the EVADE program shows the
new bookmark’s location in time format, Time (hr), (min), (sec).

5. Bookmarks are automatically saved in the dcf file when the EVADE program is exited
and re-opened using the Open command from the File menu.

6. The new bookmark appears as the last bookmark in the tabs information area, which is
displayed when the Active Bookmarks tab is selected (located in the upper left area of the
window, as shown on Figure 34).
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Figure 34. The “New Bookmark” added to the dust concentration graph. This bookmark is also
shown on the Active Bookmarks tabs on the left.

On/Off Max Bookmarks Command

Selecting the On/Off Max Bookmarks command from the Bookmarks menu opens a submenu
with On and Off commands. These commands allow you to turn on or turn off the five
bookmarks that are automatically created by EVADE.

When the On/Off Max Bookmarks submenu opens, the On command is checkmarked. There will
be five bookmarks located at the five maximum dust concentrations on the dust concentration
graph.

Clicking the Off command places a checkmark by it, and the five automatic bookmarks will not
be displayed in either the dust concentration graph or in the Active Bookmarks subwindow
(Figure 35). The Off command will only turn off the five automatic maximum bookmarks. If
there are any user-defined bookmarks, the user-defined bookmarks will still be available.

Clicking the On command places a checkmark by it, and the five automatic bookmarks will be
restored on the dust concentration graph and in the Active Bookmarks tab (Figure 36). This
allows the user to toggle on or off the display of the five automatic bookmarks.
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Figure 35. The On/Off Max Bookmarks command selected with the Off command checkmarked.
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Figure 36. Display of the On/Off Max Bookmarks command with the On command checkmarked.
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Playback Menu

The Playback menu displays commands that can be used during the playback of the video and
the dust concentration data graph. Click Playback on the menu bar to open a drop-down menu
which contains the following commands (Figure 37):

e Play (Ctrl+P). Clicking Play or typing Ctrl and P starts playback of the video and the
dust concentration graph. When you click on Play, the Pause and Stop commands
become enabled.

e Pause (Ctrl+U). Clicking Pause or typing Ctrl and U pauses the playback of the video
and dust concentration graph.

e Stop (Ctrl+S). Clicking Stop or typing Ctrl and S stops playback of the video and dust
concentration graph, and resets the video and dust concentration graph to the beginning.

e Audio On/Off (Ctrl+A). Clicking Audio On/Off toggles between turning off the audio
and turning on the audio, if the audio was enabled during recording.

NOTE: The left arrow and right arrow keys on the keyboard can also be used to progress
through the video. Pressing either key will advance (using the right arrow key) or retreat (using
the left arrow key) in approximately 10-second intervals each time the key is pressed. This
advance and retreat can be accomplished during the Play, Pause, or Stop modes.
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Figure 37. The Playback drop-down menu (upper left) with available commands.
View Menu

When you click on View from the menu bar, the View drop-down menu opens, listing the
following commands (Figure 38):

e Screenshot (Ctrl+Q). Clicking on Screenshot or pressing the Ctrl and Q keys on your
keyboard will allow you to take a snapshot of the current screen and save it as a JPEG file.
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e Units. Clicking on Units opens a submenu and allows you to toggle between units of
milligrams (mg/m®) or micrograms (pg/m°).

e Graph Options. Clicking on Graph Options opens the Graph Options dialog box where
you can make changes to the dust concentration graphical display which appears at the
bottom of the EVADE main window.

e Calibrate (Ctrl+L). Clicking on Calibrate or pressing the Ctrl and L keys on your
keyboard will open the Calibrate dialog box where you can calibrate the dust
concentrations using the user-defined calibration ratio which is used to correct data from
light-scattering instruments.
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Figure 38. The View drop-down menu (upper left) with available commands.

Screenshot

Clicking on Screenshot from the View menu or pressing the Ctrl and Q keys on your computer
keyboard displays a Save As dialog box for saving the current screen snapshot (Figure 39). The
default filename will be the name used for the avi file with a jpg extension. However, you have
the option of renaming the file and placing it in a location of your choice.

The Save As dialog box automatically labels the filename with the default file name
<filename>jpg. In the example in Figure 39, the file name is Blaster 8 10 11 V1. To prevent
overwriting previous screenshots, the default filename will be changed to <filename vi>.jpg.
With subsequent automatic saves, v/ will increase as follows: v/, v2, v3, etc. to differentiate
the screenshot from other screenshots.

Once the file is saved, the user can then view the jpg file using Windows Picture and Fax Viewer
or the file can be opened for viewing and editing with any jpg editing software (Figure 40). The
Screenshot command is useful for generating illustrations for reports.
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Figure 39. The Save As dialog box that opens when the Screenshot command is selected
from the View menu.
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Figure 40. Microsoft Windows Picture and Fax Viewer view of jpg file created
by the Screenshot command.
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Units

Clicking on the Units command from the View menu opens a submenu displaying Milligrams

and Micrograms (Figure 41). The program starts with the units that are standard with the real-

time datalogging aerosol monitor being used (micrograms/m® for pDR-1500, milligrams/m” for
pDR-1000 and AM-510). Clicking the other unit will convert the units in the different displays

and for the dust concentration data graph. For example, if Micrograms was originally checked,
clicking Milligrams converts all the dust concentrations to milligrams and vice versa.
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Figure 41. The Units submenu that opens when the Units command is selected
from the View menu.

Graph Options

Clicking on the Graph Options command from the View menu opens the Graph Options dialog
box which contains features you select for the dust data graph that appears on the main window
(Figure 42). This dialog box contains three main selection areas:

e Graph Scaling
e Thresholds
e Display Options

NOTE: Clicking on the Options button to the right of the Zoom bar also opens the Graph
Options window.
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Graph Scaling

This feature allows the user to set the vertical scale of the dust concentration graph by
selecting one of the following options:

e Automatic Scaling to Full Data Set. This feature sets the vertical scale of the
dust concentration data graph to the maximum dust concentration encountered in
the entire dust concentration data file.

e Automatic Scaling to Visible Data. This feature sets the vertical scale of the dust
concentration data graph to the maximum dust concentration that is currently
viewable in the graphical area. This maximum may readjust to different values as
the video and graph scroll through the data.

e Manual Upper Limit. This feature allows the user to define the upper limit of the
vertical scale of the dust concentration data graph in the unit displayed. You can
use the up and down arrows of the number selection box to select the desired
upper limit in 0.1 increments, or type the desired upper limit in the number
selection box. The upper limits that can be entered are 800 for mg/m?, 800,000 for
pug/m’, 1,000,000 for ppm, and 100 for % concentrate.
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Figure 42. The Graph Options dialog box that opens when selected from the View menu.

Thresholds

This feature allows you to input a horizontal line that represents a user-defined concentration
limit in the dust concentration data graph. This can be useful when you want to view dust
concentrations that may be above your thresholds for dust concentrations.

To add a threshold:

1. Click on the Add Threshold... button on the Graph Options dialog box. The Edit
Threshold dialog box will open (Figure 43).
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2. Enter a name for the new threshold in the Name text box.

3. Enter a user-defined threshold limit or select a limit (using the up and down arrows to
increase or decrease the threshold in 0.1 increments) in the Threshold Value (ng/m®)
text box. You must ensure that the threshold value is entered in units requested, either
pg/m’ or mg/m’.
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Figure 43. The Edit Threshold dialog box that opens when you click on the
Add Threshold button.

4. In the Color box, select the down arrow or just select the Color box to open the drop-
down color selection dialog box, showing Available Colors and Standard Colors.
Select a color for the threshold line (Figure 44).

Selecting the Advanced button on the color selection dialog box opens the advanced
drop-down dialog box where you can use the slider bars for R, G, B, and A (R=red,
G=green, B=blue, and A=opacity) to change the colors and opacity of the threshold
line (Figure 45).
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Figure 44. The Edit Threshold dialog box showing the drop-down color selection box.
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Figure 45. The Edit Threshold dialog box showing the drop-down advanced
color selection box.

5. In the Line Style box, select the down arrow or simply select the box to open a drop-
down box containing six different line styles (Figure 46). Select one of the line styles,
then click on the Ok button to create the threshold lines.
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Figure 46. The Edit Threshold dialog box showing the drop-down line style selection box.

6. Creating multiple thresholds. The user can also create additional thresholds which
will be all displayed concurrently (Figure 47). There is no limit to the number of
thresholds that can be created.

7. Deleting thresholds. The user can delete any or all of the thresholds by clicking on the
red X button next to the threshold to be deleted (Figure 47). It should be noted that
any thresholds created will remain active in other EVADE analyses, both when

opening new dust cam files (dcf) or creating new analyses, until they are actually
deleted.
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Figure 47. The Graph Options dialog box showing additional thresholds added to the graph.

Display Options

This feature contains three selection options for displaying information on the dust
concentration data graph on the EVADE main window. These display options are on the
upper right side of the Graph Options dialog box under Display Options and include:

e Show bookmarks
e Show thresholds
e Show grid lines

A checkbox beside each option allows you to display or hide the corresponding option. You
can set your preferences by selecting or deselecting the following options (a checkmark in
the checkbox indicates that the option is selected):

e Show bookmarks. When selected, this option will display all the bookmarks in the
graph area. When deselected, all the bookmarks will be hidden. Note: the On/Off
Max Bookmarks command under the Bookmarks menu will override this option. If
On/Off Max Bookmarks is Off, then this option will not function.

e Show thresholds. When selected, this option will display all the user-defined
thresholds. When deselected, all the thresholds will be hidden.

e Show grid lines. When selected, this option will display the background grid lines in
the graph area. When deselected, the background grid lines will be hidden.

Calibrate

Selecting Calibrate from the View menu allows you to select the calibration ratio which is used
to correct light-scattering, dust-measuring devices such as the 1000-pDR or 1500-pDR for the
characteristics of the dust type being measured. This procedure is recommended for all light-
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scattering instruments [Williams and Timko 1984]. Correction is accomplished using a
gravimetric sampler along with the light-scattering instrument (the 1500-pDR has a built-in
gravimetric) [Reed et al. 2012]. The sampling time period of the gravimetric and light-scattering
instrument must be similar. The ratio is calculated using the following equation (also shown in
the Sampling Procedure section):

Grav

Ratio =
Instant

where Ratio = the calibration ratio;
Grav = the gravimetric time-weighted average (TWA) concentration; and
Instant = the real-time optical TWA concentration from the 1500-pDR.

Next, the calibration ratio is multiplied by each real-time optical concentration recorded by the
1000-pDR or 1500-pDR in order to obtain absolute concentrations which can be comparable to
other concentrations.

To use the Calibration command:

1. Click on Calibrate in the View menu or type the keystrokes Ctrl and L. The Calibrate
dialog box will open as shown in Figure 48.

2. Enter the calibration ratio in the box to the right of Calibration Ratio or select the
calibration ratio by using the up and down arrows in the box. Each click of the up or
down arrow will increase or decrease the calibration ratio by 0.01. The calibration ratio
must be within a range of 0.01 to 100. The default calibration ratio is 1.00.

3. After entering the calibration ratio, click the OK button to activate the calibration. This
action will multiply all the real-time dust concentrations by the calibration ratio. For
example in Figure 48, the ratio entered is 1.15. Therefore, all the real-time dust
concentrations will be multiplied by the ratio 1.15. The calibration will be reflected in the
number field to the right of the Reading label above the graph and on the y-axis of the
dust concentration graph.

4. To clear or reset the calibration ratio, click on the check box next to “Restore original
data values.” Or, enter 1.00 in the calibration ratio.
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Figure 48. The Calibrate dialog box for entering the calibration ratio.

Help Menu

When you click on Help from the menu bar, the Help drop-down menu opens, listing the
following commands (Figure 49) that provide help and information about the EVADE software
program:

e View Help. Clicking on View Help opens the EVADE Help Files window.

e View Playback Details. Clicking on View Playback Details opens an informational
window displaying the active codecs.

e About. Clicking on About opens the EVADE program version dialog box.
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Figure 49. The Help drop-down menu with available commands.

View Help

Clicking on the View Help command from the Help menu opens the EVADE Help Files window
where the user can find information about the EVADE program by browsing the topics listed in
the column on the left (Figure 50). The user can search for information by browsing for
information through the Contents tab, by using the Index through the Index tab, or by typing
search keywords in the text box under the Search tab.
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Figure 50. Display of the Help window.
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View Playback Details

Clicking on the View Playback Details command from the Help menu opens a window that
displays information about the active codecs being used by the EVADE program (Figure 51).
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Figure 51. The Active Codecs dialog box which opens when Video Playback Details
is selected from the Help menu.

About

Clicking on the About command from the Help menu opens a dialog box which provides
information on the EVADE program version and displays the NIOSH disclaimer (Figure 52).
Click OK to return to the EVADE program.
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Figure 52. The informational dialog box that opens when About is selected from the Help menu.
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Menu Tabs

The menu tabs are located just below the menu bar in the upper left corner of the EVADE main
window. The menu tabs open subwindows just below the tabs. When selected, these tab
subwindows provide information and icon buttons to perform various actions Following are the
available menu tabs (shown in Figure 53):

e Details
e Active Bookmarks

e Active Files

e Notes
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Figure 53. The information that is displayed on the Details tab.
Details

Clicking on the Details tab (Figure 53) opens a subwindow which provides information about
the dust concentration data file. This is an informational tab only. No commands or preferences
can be selected using this tab. The information listed includes:

Date: The date in day, month, year format.

Model:  The model of the dust sampler being used, 1500-pDR, AM-510, or 1000-pDR.
Duration: The length of the video and dust files in hours:minutes:seconds (hh:mm:ss).
Max: The maximum dust concentration encountered in the dust concentration data file.
Max @: The time (in hh:mm:ss format) in which the maximum dust concentration occurs.
Time: The elapsed time (in hh:mm:ss format) as the video and dust graph are played.

Units: The units of the dust concentrations in milligrams or micrograms. The
concentration is either mg/m® or pm/m’.
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Active Bookmarks

Clicking on the Active Bookmarks tab opens a subwindow which lists the five automatic
bookmarks and any bookmarks that have been created by the user (Figure 54). The subwindow
displays the following four columns:

#. This column displays the bookmark number.

e Description. This column displays the descriptions of the five automatic bookmarks,
which are automatically labeled Max# (for example, Max1 for bookmark 1, Max2 for
bookmark 2, etc.). Also listed are the user-defined descriptions for bookmarks created by
the user.

e Time. This column displays the location where the bookmark occurs in the data and
video files.

e Reading. This column displays the dust concentration reading at the bookmark location
in pg/m’, mg/m’, PPM, or % Concentration depending upon the units selected.

Once more bookmarks are created such that the bookmark list fills the subwindow display, a
scroll up and down bar will appear on the right side of the interface. Click on the bar and move
the vertical bar up or down to scroll up or scroll down through the bookmarks. Clicking on a
bookmark highlights the bookmark, and the video screen and dust data graph advance to the
bookmark location.

Delete Bookmarks
To delete a bookmark:

1. Right-click on a bookmark to display a dialog box with one option, Click to DELETE
this Bookmark.

2. Click on this option to delete the selected bookmark.
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Figure 54. The Information displayed on the Active Bookmarks tab.

Active Files

Clicking on the Active Files tab (Figure 55) opens a subwindow that lists the files used by
EVADE for the present dust exposure analysis. This is an informational tab only. No commands
or preferences can be selected using this tab. The information listed includes:

Directory: Lists the directory of the active files being used by the EVADE software.
Video: Lists the filename of the active video file being used.

Data: Lists the filename of the active dust concentration data file being used.
Bookmark:Lists the filename of the active bookmark file being used.

Additionally, exported bookmark files, screenshot files, and saved Notes files used for the
current analysis will be listed in this area.
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Figure 55. Information displayed on the Active Files tab.
Notes

Clicking the Notes tab opens a subwindow that allows the user to enter notes during the dust
exposure analysis (Figure 56). To enter a note, just begin typing in the subwindow below the
Notes tabs. Above this open area are six icon buttons, described next. Upon exiting EVADE, any

notes are automatically saved to the default filename, which is described in the following Save
As section.
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Figure 56. Example notes typed in the subwindow area below the Notes tab.
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Icon buttons on the Notes Tab:
Starting on the left side of the menu bar in the Notes subwindow, the icon buttons are:

e Save As. Clicking on the Save As button opens the Save As window (Figure 57). The
default file name displayed is the name of the video file with an r¢f extension. Anything
written in the Notes Tab will be automatically saved to this file name in r#f format. This
default file will be overwritten automatically. You can edit the filename in this window if
desired, to prevent overwriting previous notes or to make changes. Subsequent Save As
default file names will include V1 such that the filename will have the format
filename_V1.rtf; the V1 will increase to V2, V3, etc. as additional saves are
completed. When EVADE is exited and re-opened, the EVADE program will display the
notes from the original default filename (videofilename.rtf).
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Figure 57. Display of the Save As dialog box when the Notes tab is selected

e Open RTF. Clicking on the Open RTF icon button (second icon from the left) allows
you to open other previously created note files. A dialog box will open that allows the
selection of a note file to be opened and displayed in the Notes tab. You can select the r#f
file to open in the Notes tab. Opening an existing note file will clear any previous notes
entered into the Notes menu tab.
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Figure 58. The Open dialog box that opens after clicking the Open RTF button
under the Notes tab.

Place or Insert Frame Time. Clicking this icon button enters the time corresponding to
the location of the vertical green bar on the dust data graph into the Notes subwindow
(see the time displayed in green in Figure 58). Subsequent clicks of the Place icon will
enter additional times which will be different from the original entered time if the video
is playing.

Bold, Italic, and Underline. These buttons are used to format the text similar to text
formatting in a word processing program.

Print. Clicking on the Print icon opens the Print dialog box which allows you to send the
notes to a printer (Figure 59).
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Figure 59. Display of the Print dialog box from the Notes tab.
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Action Buttons

The action buttons are located on the left side of the main EVADE window below the tab
subwindow area where information from the menu tabs is displayed. The action buttons can be
used as shortcuts to conduct their specified operation. The following is a description of each
button.

Open File

Clicking on the Open File action button (Figure 60) displays the Open dialog box which allows
you to open a previous dust exposure analysis (a shortcut instead of selecting the File menu and
the Open command). The acceptable file types are the dcf files. When the Open dialog box
opens, the displayed default directory is the EVADE directory. Other directories can be searched
by browsing the directory box at the top of the Open dialog box. Selecting a dcf file will allow an
evaluation using the previously associated dust concentration data and video files. (See the Open
Command section in this document for additional information on the Open command.)
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Figure 60. The Open File action button (circled).
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New Project

Clicking on the New Project action button (Figure 61) is the same as selecting File from the
menu bar and then selecting the New Project command. The New Project command opens the
Create New EVADE Project dialog box (Figure 62), allowing you to create a new dust exposure
analysis.
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Figure 61. The New Project action button (circled).
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Figure 62. The Create New EVADE Project dialog box when the New Project icon
button is selected.
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Play

Clicking on the Play action button (Figure 63) starts the video playback and allows you to
conduct the dust exposure analysis for the job occupation. You can also select Play from the
Playback menu on the menu bar.
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Figure 63. The Play action button (circled).
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Pause

Clicking on the Pause action button (Figure 64) stops the video at its current location. Clicking
on the Play icon button will restart the video at the currently stopped location. You can also
select Pause from the Playback menu in the menu bar.
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Figure 64. The Pause action button (circled).
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Stop

Clicking on the Stop action button will stop the video playback and reset the video and dust
concentration graph to the beginning (Figure 65). Clicking on the Play icon button will restart
the video, but it will restart at the beginning. You can also select Stop from the Playback menu
in the menu bar.
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Figure 65. The Stop action icon button (circled).
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Audio On/Off

Clicking on the Audio On/Off (or Mute) action button (Figure 66) will toggle between the sound
being on or off. Clicking on this button will have no effect if the sound was turned off during
video recording. You can also select Audio On/Off from the Playback menu in the menu bar.

L LILa TS R TR TER I e

File Boskmarks Playbsck View Help

Detsis | Active Bookmarks | Actie Files | Nates

Date: 10-Ausg-2011

Mol POR-1500

Duration: 03:04:48

Max: 851468

Mazx §: O3:57:08

Time: 00:08:27

Units: Mierograms

Reading: 408.870

Paused: Blaster 8-10-11dcf

Figure 66. The Audio On/Off (or Mute) icon button (circled).

Zoom Bar

A Zoom bar (Figure 67) is located directly above the action buttons. Sliding the bar horizontally
to the left or right will change the X-axis scale of the dust data graph. Following are ways to use
the Zoom bar to read the dust concentration data graph:

e Sliding the Zoom bar to the right will shorten the X-axis scale resulting in the dust data
being displayed over a short interval. The dust data will look very condensed.

e Sliding the bar to the left will lengthen the X-axis scale resulting in the dust data being
displayed over an expanded interval. Lengthening the X-axis scale will allow you to
better conduct the dust exposure analysis as you will more easily follow the individual
real-time dust concentrations.

e Another method that can be used to expand or contract the scale of the x-axis is to use the
scroll button on the mouse while the cursor is located in the dust data concentration
graph.
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Figure 67. The Zoom bar and Options button (circled).

Options Button

Clicking on the Options button to the right of the Zoom bar opens the Graph Options dialog box
(Figure 68). See the Graph Options section in this document for detailed information on the
Graph Options dialog box.
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Figure 68. Display of the Graph Options dialog box when selecting the Options button
to the right of the Zoom Bar.
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Graph Viewing Area

The graph viewing area, located at the bottom of the main EVADE window (Figure 69), contains
the dust concentration data as a line plot. The graph contains the following features:

e The blue line in the graph is the dust concentration data.

e The X-axis of the graph contains the timeline of the video file in hours:minutes:seconds
format.

e The Y-axis contains the dust concentrations in either ug/m3 or mg/m3, PPM, or %
Concentration, depending on the units selected.

e An important feature of the graph is the green vertical line. This green line indicates the
current time and position of the video and dust concentrations. The current time is
highlighted by the time display outlined in the x axis. The reading above the green
vertical line just above the graph is the dust concentration at that moment. The video
displays the current action occurring at the green vertical line.

e The red vertical lines are the bookmarks. There are five automatic bookmarks selected at
the five highest dust concentrations. These bookmarks are labeled Max1, Max2, Max3,
Max4, and Max5.

The graph will automatically scroll during video playback, showing the current dust
concentration on the graph coordinated with the current action being displayed on the video.

To fast forward or fast reverse the video and dust concentration data graph together, do one of
the following:

e Use the slider bar directly below the video display dragging it to the left or right.

e To fast forward, left-click on the dust data graph and hold down the mouse click while
dragging the mouse to the left. To fast reverse, left-click on the dust data graph and hold
down the mouse click while dragging the mouse to the right.

Do one of the following to expand or decrease the X-axis scale of the dust concentration graph:

e Place the mouse cursor in the graph area and scroll the mouse forward with the mouse
wheel to increase the X-axis scale of the graph. Scrolling backwards with the mouse
wheel decreases the X-axis scale.

e Sliding the zoom bar to the right decreases the X-axis scale, while sliding it left increases
the X-axis scale.
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Figure 69. The EVADE main window after either the New Project or Open command
under the File menu is used to set up a new dust exposure analysis.

Video Display Area

The video display, located just above the dust concentration graph (Figure 69), shows the current
actions in the video that correspond to the dust concentration at the green vertical bar on the
graph. Fast forwarding or fast reversing is accomplished by placing the cursor on the dust
concentration graph and left-clicking the mouse while dragging the dust concentration data graph
as previously mentioned for the dust data graph

Fast forward or fast reverse through the video and dust concentration data can also be
accomplished through the use of the slider bar located directly below the video display (Figure
70). Left-clicking on the slider bar and dragging it to the right will fast forward the video and
corresponding dust concentration data. Dragging the slider bar to the left will fast reverse the
video and corresponding dust concentration data.
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Figure 70. Display showing the location of the slider bar below the video display.

Another way to fast forward or fast reverse through the video is to use the left or right arrow
keys on the keyboard. The right arrow key will advance the video and graph approximately 10
seconds each time the key is pressed. The left arrow key will reverse the video approximately 10
seconds each time the key is pressed.
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Data File: EVADE’s Universal Format

EVADE’s universal format data file is a four-column file format which allows you to input data
from sources that cannot normally be read by EVADE. The four columns of EVADE’s universal

format data file are shown in Figure 71, in the following order (from left to right): data point #,
date, time, and concentration.

. 09:13:54,32.89
. 09:13:56,18.73
. 09:13:58,5.74
. 09:14:00,13.39
17.57
,9.03

, 09:14:06,5.86
. 09:14:08,6.32
. 09:14:10,2.95
. 09:14:12,3.63
. 09:14:14,6.02
. 09:14:16,5.51
, 09:14:18,6.09
. 09:14:20,3.11
. 09:14:22,5.02
, 09:14:24,2.48
. 09:14:26,2.79
. 09:14:28,10.32
. 09:14:30,7.29
. 09:14:32,4.55
. 09:14:34,6.33
. 09:14:36,5.06
. 09:14:38,3.6
. 09:14:40,6.33
. 09:14:42.5.61

100% (=) N @

Figure 71. A screenshot of a dust concentration file in EVADE’s universal format
opened in WordPad.

EVADE’s universal file format is a comma delimited (csv) file and does not contain any header

information. This file can easily be created in Microsoft Excel as long as the resulting file is
saved as a csv file.

When opening a new EVADE analysis, the software will automatically detect this universal

format file. Once detected, a dialog box will open (Figure 72) which contains the following input
fields:

e Instrument model. This field provides a blank space where you input the instrument

model number or identification number. In the example, “test” is used for the instrument
model number.

e Measurement units. In this field, you click in the checkbox to select the units of the dust
concentration data. You can select one of the following options: % concentration, PPM,

ug/m® or mg/m’. This selection allows EVADE to display the concentration in the proper
units.

The units ug/m’ and mg/m’* are the common units of concentration for dust sampling.
The units % concentration and PPM are offered to allow the user to use EVADE to
analyze exposure sources for other substances (e.g., gas and fumes). The user is
responsible for obtaining the concentration data for the other substances to be analyzed
and knowing the proper units of the data. Unit conversion between ug/m® and mg/m’ is

available in EVADE. However, there is no unit conversion available between %
concentration and PPM.
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{8 Create New EVADE Project

1. Select video file... C\HelmetCAM\firecam universal I\PICTO001AVI
2. Select datalog file.. | Not se

A Universal format data file has been detected. Please specify the
instrument model and measurement units below.

Instrument model Measurement units
test © % concentration

Maximum 13 characters

¥ 000k

Reading: 0.000

Paused:

Figure 72. The dialog box that opens when EVADE’s universal file format is detected
with the dust concentration data file.

Editing Dust Concentration Data Files

The dust concentration data file downloaded from the three real-time datalogging aerosol
monitors (pDR-1000, pDR-1500, or AM-510) or in universal format is directly input in EVADE
which allows display of the dust concentrations and the dust concentration graph during
playback of the video. There may be times that the data may need to be edited, such as editing
for negative dust concentration values, truncating dust data files that are longer than video files
or modifying the start time to coincide with the video start time. To maintain file integrity, it is
not recommended to edit the header information in the file. Microsoft Excel does not allow for
ease of editing of the csv data file because saving as a csv file in Excel removes the column
width formatting.

WordPad or Notepad can be used to edit the dust concentration data files. WordPad will allow
saving the edited data file with the correct columnar format as a text file (¢xf), Notepad will allow
saving the edited data file with the correct columnar format as a print file (prn). It is important
that the file be saved as a csv file. This can be accomplished easily by adding the extension csv at
the end of the file name when saving the file. For example, Figure 73 displays a typical pDR-
1500 dust concentration file opened in WordPad. The header information is located in the first 24
lines of the file with the dust concentration data listed beginning on line 25.

To edit the data file, open the data file to be edited in WordPad or NotePad. At this time any
edits to the file can be completed. For example, if correction for the negative value of respirable
dust concentration is needed, make the edits by seeking the negative value. Delete the negative
sign in front of the dust concentration and replace it with a space.
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Changing the start time of the dust data file is more complex. If the start time of the data file
needs to be changed, entire data lines can be deleted or added until the correct start time is listed
underneath the header information. It is important that the entire line be added or deleted while
maintaining the line format (correct number of characters/line). Additionally, in the header
information there is a line labeled “number.” The actual number in this line will need to be
changed to reflect the actual number of data points/lines in the file.

Once the edits are complete, the data file can be saved. It is best to save the newly edited file
with a new name to ensure the original file does not become corrupted. When saving the new
file, save it as a csv file, not as a txt or prn file.

- : T I

, "PDR-1500",
10221429907

"0

Na ", "ug/m3"

"TEMPUNITS *, C

"RH CORRECT ", "ENABLED "
i

emp, RHumidity, AtmoPressure, jat
1s.9, 36, 736, 11,

,  01-Jan-2166
, 01-Jan-2166 o
100% & J O}

Figure 73. A typical pDR-1500 data file displayed in WordPad.
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Troubleshooting

This section includes two examples of problems you might encounter while using the EVADE
software, and actions for resolving these situations are provided.

Program works as expected, but no video is displayed

If the program appears to be functioning normally, dust and video data are loaded, but no video
is displayed, the most likely cause is a missing or incorrect video codec. There are several
possible solutions to this problem.

If you have not already done so, try installing the DivX or Xvid codec (see the Installing the
EVADE Software Program section in this document for details), or install the software that came
with your camera.

If this does not fix the problem, verify that the video file can be played back in Windows Media
Player. First, launch Windows Media Player from the Start menu, then locate your video file and
drag-and-drop the video file onto the Windows Media Player window. If the video does not play,
it’s possible the file is damaged, or the video codec used by the file is not supported by the
installed codecs. Try playing other video files from the camera in Windows Media Player; if
none of them display video during playback, try uninstalling and reinstalling the camera’s
software and/or the DivX or Xvid codec.

If the video plays in Windows Media Player, but not in EVADE, it’s possible that one of the video
codecs installed on the system is incompatible with EVADE. Information about what codecs are in
use can be viewed by opening the Help menu and choosing Video Playback Details which will
display a list of the active codecs being used by EVADE. If any third party codecs show up here, it
may be necessary to uninstall them and install DivX, Xvid, or another codec.

Another solution to correct this video problem is to convert the avi video file into a wmv file.
This can be accomplished using separate third-party software. The EVADE video display is
based upon the Windows Media Player and should play the wmyv file.

Video playback works initially and then stops moving

In some cases, most often after scrolling quickly from one location to another or rapidly
playing/pausing, the video playback can freeze and refuse to play/seek to a new location. In most
cases this can be fixed by stopping the video and pressing Play again from the Playback menu.
If this does not fix the problem, close the program by clicking on Exit from the File menu, and
restart EVADE.

If this happens frequently, it may be due to the video codec being used (such as DIVX, XVID,
etc.). You could try uninstalling your current video codec and installing a different one. The codec
XVID was found to perform better, eliminating video freezing, during initial software testing.

Another cause could be that the SD card used in the video camera may not have sufficient
read/write speeds which can result in dropped video represented by video stoppages during
playback. Use an SD card of class 6 or higher which has higher read/write speeds to prevent
dropped video.
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Software Disclaimer of Liability Clause

The Enhanced Video Analysis of Dust Exposures (EVADE) software was developed by researchers at the National Institute for Occupational Safety and Health (NIOSH). It is provided “as is” without warranty of any kind, including express or implied warranties of merchantability or fitness for a particular purpose. By acceptance and use of this software, which is conveyed to the user without consideration by NIOSH, the user expressly waives any and all claims for damage and/or suits for personal injury or property damage resulting from any direct, indirect, incidental, special or consequential damages for loss of profits, revenue, data or property use, incurred by the user or any third party, whether in an action in contract or tort, arising from access to, or use of, this software in whole or in part.



Any questions concerning this product can be directed to the Office of Mine Safety and Health Research (OMSHR) via email at OMSHR@cdc.gov.





System Requirements

To run the EVADE program effectively, your computer should meet the following system requirements:



		Operating system

		Windows 2000 / XP / Vista / Windows 7







		Hardware

		Minimum

		Recommended





		Processor

		1 gigahertz (GHz) processor

		2 gigahertz (GHz) processor or higher



		Disk space

		1.0 gigabyte (GB) available disk space

		4.0 gigabyte (GB) available disk space



		Memory

		512 MB of RAM

		1.0 GB of RAM



		Screen resolution

		800 x 600

		1024 x 768 or higher
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[bookmark: _Toc266702218][bookmark: _Toc376936702][bookmark: _Toc386204196][bookmark: _Toc390083212]Abstract

[bookmark: _Toc266702219]This report describes the process of performing a Helmet-CAM Respirable Dust Survey and the Enhanced Video Analysis of Dust Exposures (EVADE) software program, Version 1.0, that is designed for analyzing dust exposure in the mining environment at surface mines through the simultaneous use of video and real-time dust concentration data. The Helmet-CAM procedure, developed by researchers at the National Institute for Occupational Safety and Health (NIOSH) for personal sampling of respirable dust, is a technique that uses a video camera worn by the worker to provide a visual record of the worker’s activities concurrently with data collected by a real-time datalogging aerosol monitor also worn by the worker. The EVADE software program merges the video file and dust concentration data file, allowing the user to use a computer to view them at the same time to identify potential dust exposure sources. This report defines the input file types and provides instructions for installing and operating the EVADE software. A step-by-step procedure is included to aid the user in conducting an analysis for identifying respirable dust exposure sources. 
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The use of video in conjunction with real-time dust exposure monitoring has been employed in the past to identify sources and routes of worker exposure to different chemical agents. The subsequent video analysis allows for controls to be developed to prevent the exposures from the newly identified sources. However, the drawback in past research was that the video and sampling equipment were so large such that the video analysis was only able to be conducted at a stationary location. Additionally, the output from the sampling was limited as it had to be overlayed directly onto the video film which limited the analysis of the sampling data with the video data [Rosen and Lundstrom 1987; Rosen and Andersson 1989; Gressel et al. 1988]. Advances in technology have miniaturized the video and sampling devices so that they are portable and can be carried by the worker with minimal inconvenience. Additionally, the video and sampling data are currently available in digital format and can be merged using a separate software program [Rosen et al. 2005] [NIOSH 1992]. However, these programs are not commercially available. A method to overcome the lack of availability of these programs is to customize commercially available software to open the video and sampling data outputs in separate windows on a computer [Xu and McGlothlin 2003]. Another method is to develop a software program which can merge the two data sources. This has been accomplished in past research, but this program is not publicly available [Rosen et al. 2005].

The Enhanced Video Analysis of Dust Exposures (EVADE) software program was developed by researchers at the National Institute for Occupational Safety and Health (NIOSH) and is used for exposure analysis of workers to respirable dust. NIOSH researchers also developed a sampling procedure using a real-time datalogging aerosol monitor and a portable video camera (Helmet-CAM) to be used at surface mine sites to monitor respirable dust concentrations while recording the worker’s perspective during the performance of their job. This procedure may be difficult to use in underground mining situations because of poor underground lighting conditions and because the real-time datalogging aerosol monitor and portable video cameras used are not typically Mine Safety and Health Administration (MSHA) approved for intrinsic safety (Code of Federal Regulations, Title 30, Chapter 1, Subchapter B, Part 18.68).

The results of this monitoring are a real-time dust concentration data file and a corresponding video file. EVADE meshes the two data files (dust concentration and video) to allow for analysis of sources of dust exposure of workers. This software program displays a graphical depiction of the dust concentrations synchronized to the video of the worker’s job activities, and allows for playback, fast forward and reverse, and pause. Additionally, events with elevated dust levels can be bookmarked in the program for more detailed review. A bookmark is a link to an individual dust exposure event during the respirable dust sampling time period. This software allows the user to conduct an analysis of the worker’s occupational activities and develop a source database for respirable dust exposures at surface mine operations. The results of this analysis may lead to the development of engineering and behavioral controls that may prevent the overexposures to respirable dust from their sources.

[bookmark: _Toc327255087][bookmark: _Toc376936704][bookmark: _Toc386204198][bookmark: _Toc390083214]Sampling Equipment

The EVADE software uses dust concentration data obtained from a respirable dust personal sampling survey conducted on a specific job activity performed by a worker. The equipment required for conducting the survey consists of a real-time datalogging aerosol monitor and a video camera. NIOSH’s Office of Mine Safety and Health Research (OMSHR) typically uses one of two devices for real-time dust sampling. The data output of these two devices are compatible with EVADE; these devices are Thermo Scientific’s personal Data Ram™ 1000 (pDR-1000) and the Thermo Scientific personal Data Ram 1500 (pDR-1500)[footnoteRef:6] (Figure 1). Their data files are compatible with the EVADE software without requiring any editing of the data files. Another real-time datalogging aerosol monitor commonly used by the mining industry is the Sidepak Personal Aerosol Monitor AM510 manufactured by TSI, Inc. (AM-510)[footnoteRef:7]. The data output from the AM-510 is also compatible with the EVADE software. Other real-time datalogging aerosol monitors may be available from other manufacturers. These other real-time datalogging aerosol monitors can be used with EVADE, but currently their data output would require being input using EVADE’s universal format. EVADE’s universal format is a four-column comma delimited file (csv) where the first column represents data point number, the second column represents date, the third column represents time, and the fourth column represents dust concentration (see the Data File: EVADE’s Universal Format section in this document for guidance). [6:  Mention of any company or product name does not imply endorsement of that product by NIOSH.]  [7:  Mention of any company or product name does not imply endorsement of that product by NIOSH.] 


The pDR-1000, pDR-1500, and AM-510 are real-time datalogging aerosol monitors which log dust concentrations at user-selected time intervals. The pDR-1000, pDR-1500, and AM-510 real-time datalogging aerosol monitors record the dust concentrations to a data file that can be downloaded in the comma separated value (csv) format, which can be used by the EVADE software.

The pDR-1000 is a passive real-time datalogging aerosol monitor with sensor response optimized to a particle-size range with aerodynamic diameters of 0.1 µm to 10 µm. A passive sampler is defined as a sampler that uses ambient airflow from the surrounding environment to draw the surrounding air into the optical chamber to provide a dust concentration measurement. The pDR-1500 and AM-510 are active real-time datalogging aerosol monitors which contain an air pump used to draw in or collect dust samples at a specific user-defined flowrate and can be used with particle-size selective separators. An active sampler uses a pump to pull the surrounding air at a constant preset flowrate into the optical chamber to provide a dust concentration measurement.

Sampling with active real-time datalogging aerosol monitors is preferred due to the ability of these monitors to use particle-size selective separators to minimize sampling of large particles, resulting in precise measurement of concentrations [Willeke and Degarmo 1988; Quintana PJE et al. 2000; Liu LJS et al. 2002; Chakrabarti et al. 2004]. However, recently it has been found that passive sampling with real-time datalogging aerosol monitors provides consistent results similar to active sampling using real-time datalogging aerosol monitors provided that the gravimetric sampling is conducted in conjunction with real-time sampling [Listak et al. 2007; Thorpe and Walsh 2007]. Whether sampling with active or passive devices, it is recommended to conduct gravimetric sampling in addition to real-time sampling [Williams and Timko 1984]. Generally, active real-time datalogging aerosol monitors are preferred because of their ability for optional particle-size selection and as they may have a provision for gravimetric sampling without having to use an additional gravimetric sampler.
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[bookmark: _Ref303845201][bookmark: _Toc327255134][bookmark: _Toc390083711]Figure 1. Thermo Scientific’s pDR-1000 sampler (left) and pDR-1500 sampler (right).

The EVADE software uses video from the camera used in the dust exposure survey. The video camera that works best is one that is small enough to be attached to the worker’s hardhat. Past testing of the EVADE software has been completed using the V.I.O. Point-of-View (POV)[footnoteRef:8] video camera. This is a small compact video camera where the lens component is attached to the body of the video camera via a length of cable (Figure 2). This allows the camera body to be placed in the provided carrying case/pouch and the lens can be attached to the worker’s helmet which allows viewing of the work activity. Many other compact video cameras are available and can be used as long as the video file is compatible with EVADE. The video file that EVADE can read is the digital video file which has an avi filename extension. It can also read a wmv file. Because high-definition (HD) video is becoming more prevalent, EVADE has been modified to accept MPEG-4 (mp4) video files. Any video camera can be used with EVADE as long as the output is avi, wmv, or mp4. The EVADE software is currently not compatible with mov files. [8:  Mention of any company or product name does not imply endorsement of that product by NIOSH.] 
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[bookmark: _Ref348106104][bookmark: _Toc390083712]Figure 2. The V.I.O. Point-of-View video camera used in the Helmet-CAM, showing the body of the camera and the lens component (below the body) attached by cable.

It is assumed that the user is familiar with the video recording and dust sampling instruments being used during the respirable dust personal sampling procedure, called a Helmet-CAM survey. The user should refer to each device’s operating manual to properly set up the device for sampling.

[bookmark: _Toc327255088][bookmark: _Toc376936705][bookmark: _Toc386204199][bookmark: _Toc390083215]Sampling Procedure

The data collection using the Helmet-CAM consists of a combination of respirable dust personal sampling and a video recording performed simultaneously while the worker performs their regular duties. The data can then be analyzed to determine the sources of respirable dust exposure to the workers who are engaged in different job occupations.

 Using the pDR-1500 for respirable dust sampling allows for logging of real-time dust concentrations at user-specified intervals and can simultaneously accomplish gravimetric sampling with its built-in gravimetric filter [Reed et al. 2012]. Other real-time datalogging aerosol monitors may require a separate gravimetric sampler operating simultaneously. The gravimetric filter allows for correction or calibration of the real-time concentrations from the real-time datalogging aerosol monitor to the type of dust being sampled.

Correction or calibration is recommended for all light-scattering instruments [Williams and Timko 1984]. The sampling time period of the gravimetric and light-scattering instrument must be similar. The calibration ratio is calculated using the following equation:



where	Ratio = the calibration ratio;

Grav = the gravimetric time-weighted average (TWA) concentration; and

Instant = the real-time optical TWA concentration from the 1500-pDR.

Next, the calibration ratio is multiplied by each real-time optical concentration recorded by the real-time datalogging aerosol monitor in order to obtain absolute concentrations which can be comparable to other similarly quantified concentrations of other occupations from other real-time datalogging aerosol monitors.

The pDR-1500 also allows size-selective sampling with D50 cut points ranging from 1 to 12 µm using an ACGIH convention using optional cyclones that have been developed for this monitor [Lippmann 1995]. The D50 represents the median diameter of the particle-size range being sampled. Other size-selective components (e.g., 10-mm Dorr-Oliver nylon cyclone, Higgins-Dewell cyclone) may also be used instead of these optional cyclones [Reed et al. 2012]. For example, to sample the respirable size range, the 10-mm Dorr-Oliver nylon cyclone, which has a D50 of 3.5 µm at 1.7 L/min flowrate (2.0 L/min for coal), is a possible cyclone that might be selected [Bartley et al. 1994].

The pDR-1000 or the AM-510 can be used as a sampling device, but an additional gravimetric sampler with a respirable dust preseparator would be recommended to allow for calibration, as the pDR-1000 and the AM-510 have no built-in capability for gravimetric sampling. However, gravimetric sampling may not be required as long as the user understands the limitation of the resulting data—that the resulting concentrations will be relative concentrations, not concentrations that are representative of the true mass [Williams and Timko 1984]. These resulting concentrations would not be comparable with the different occupational results from other real-time datalogging aerosol monitors.

[bookmark: _Toc376936706][bookmark: _Toc386204200][bookmark: _Toc390083216]Respirable Dust Sampling

The following are some helpful suggestions for setting the real-time datalogging aerosol monitor for respirable dust sampling:

· Use new batteries for each new sampling period.

· Zero the real-time datalogging aerosol monitor prior to each use.

· Set the logging period for 1 or 2 seconds. Longer logging periods are more difficult to analyze with EVADE as longer time periods make it difficult for the user to identify exposure sources.

· Set a calibrated flowrate appropriate for the particle-size range desired. Refer to the operation manual for flowrate adjustment and calibration. Typically, a Dorr-Oliver 10-mm cyclone is used for respirable dust measurements, requiring a 1.7 L/min flowrate at metal/nonmetal mine sites (2.0 L/min flowrate for coal mine sites). There is no flowrate for the pDR-1000, but the gravimetric sampler’s pump flowrate should be set to match the size-selective preseparator used.

· Disable any alarms. They are not needed.

· Set units to “Mass (ug/m3)” for the pDR-1500 or mg/m3 for other monitors. NOTE: The unit ug/m3 is equivalent to µg/m3.

· Synchronize the real-time datalogging aerosol monitor and video camera to the exact time on the devices before testing. This is best accomplished using the time setting on the download computer.

· Use an appropriate filter. The SKC 5-micron 37-mm polyvinylchloride filter[footnoteRef:9] has been used effectively for collecting the respirable dust sample with the pDR-1500. Other filters may be available; the important specifications are the 37-mm diameter and material type. This filter should be placed in the white filter holders with the stainless steel backing included with the pDR-1500. Store preweighed filters in a petri dish. Care should be taken when changing filters to avoid contamination of the filter [Reed et al. 2012]. [9:  Mention of any company or product name does not imply endorsement of that product by NIOSH.] 


To conduct respirable dust sampling with the pDR-1500 or AM-510, a Dorr-Oliver 10-mm cyclone (illustrated in Figure 3) or other size-selective preseparator should be attached to the inlet. This can be accomplished by attaching the cyclone to the pDR inlet with a 3-ft length of a nonelectrostatic tubing such as black conductive tubing (other silicone based tubing can be substituted). The cyclone is attached to the worker’s lapel with the real-time datalogging aerosol monitor’s body secured to the worker’s belt (Figure 3). The use of a suspension rig belt, safety vest, or backpack facilitates this setup. Once the dust sampler is set up, the video camera can be outfitted. Using the video camera, the recording unit can be placed in a pocket of the vest (shown in Figure 3) or attached to a belt, and the lens is attached to the helmet of the worker using a typical helmet flashlight mount (Figure 4).
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[bookmark: _Ref327254825][bookmark: _Toc327255135][bookmark: _Toc390083713]Figure 3. Setup of sampling devices for personal sampling.
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[bookmark: _Ref303944995][bookmark: _Toc327255136][bookmark: _Toc390083714]Figure 4. Placement of the video camera lens on the helmet.

If the respirable dust personal sampling is conducted in an operator’s cab, an alternative setup can be used. A cab setup maintains the use of the real-time datalogging aerosol monitor and the video device, but the devices are located in an out-of-the-way place in the cab rather than placed upon a worker (Figure 5). In this case the cyclone is located on the wall of the cab at the operator’s breathing level. And the video camera lens is placed in an upper corner of the cab oriented to a position that provides a good view of the operator’s work.
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[bookmark: _Ref327254785][bookmark: _Toc327255137][bookmark: _Toc390083715]Figure 5. Typical setup of sampling and video devices in an operator's cab.

[bookmark: _Toc376936707][bookmark: _Toc386204201][bookmark: _Toc390083217]Video camera setup

The following are some helpful suggestions for setting up the video camera when conducting respirable dust sampling:

· Use new batteries for each sampling period. The V.I.O. POV video camera’s recording length may be 3–4 hours with alkaline batteries and 6–8 hours with lithium batteries. Other cameras’ recording length may only be up to 2 hours. Batteries should not be reused because video recording stops soon after due to low battery power.

· Select a low-video-quality setting in the video camera setup menu. High-video-quality video files become very large (approximately 3 GB for 3 hours) and cumbersome when saving and copying. There is no observable visual loss of picture detail using low-quality video when video is played back on the computer. NOTE: The avi or wmv video files can be approximately 1.8 gigabytes (GB) for 3½ hours on low resolution. HD video files (mp4) are even larger.

· Set frame rate as low as possible (i.e., 15 frames per second) in the video camera setup menu.

· Sound should normally be turned off in the video camera’s setup menu. However, some operations may want to use sound to identify workplace surroundings.

· Set time to computer time to synchronize time with the pDR.

· Use SD (secure digital) memory cards with a minimum rating of Class 6. The class rating of SD cards refers to the read/write speed of the memory card. A card with a rating of Class 10 is best as it has a faster read/write speed than a Class 6 card. Using a card with a rating less than Class 6 will result in dropped frames in the video, making those parts of the video ineffective for dust exposure analysis.

Once the real-time datalogging aerosol monitor and video camera are in place upon the worker or in the cab, the devices’ serial numbers or labels should be documented to allow for identification of the data files when conducting the dust exposure analysis (the easiest method is to label each device with a number and use those numbers for documentation). The real-time datalogging aerosol monitor and video camera are started at the exact same time, and the worker is left to accomplish assigned duties.



Important: Start the real-time datalogging aerosol monitor and the video camera at the exact same time.



If the real-time datalogging aerosol monitor’s internal clock loses its timing, which has occurred in past studies due to setting the initial time wrong or from the internal batteries being depleted, the files can still be analyzed together because both the dust concentration data file and the video file have the same start times.

[bookmark: _Toc327255089][bookmark: _Toc376936708][bookmark: _Toc386204202][bookmark: _Toc390083218]Dust Exposure Analysis Setup

After the respirable dust and video sampling has been completed, the user must download the data files from each device. These data files will be used for analyzing the dust exposure of the worker that was sampled. If gravimetric sampling was conducted simultaneously during the survey either by use of the pDR-1500 or by other gravimetric methods, the filter should be collected and post-weighed to obtain a gravimetric respirable dust concentration. A discussion of gravimetric sampling is not provided as it is presumed that the user understands gravimetric sampling procedures.

The pDR-1000, pDR-1500, and AM-510 allow downloading of the files to a computer. To download the data, the user would use the software program provided by the manufacturer of the real-time datalogging aerosol monitor. The data should be in comma separated values (csv) format in order to be used by EVADE.

The video camera generally allows downloading of the files to a computer. The user can use the software program provided by the camera manufacturer to download the data, or typically, Windows Explorer can be used to open the directory of the device and copy the file directly from the device to the computer. The user will copy the video files from the video camera device, using either avi or mp4 files depending upon the device. There may be a thumbnail file (thm) located on the video camera device. It is not important to copy this file as EVADE does not use it during operation.

It should be noted that the avi (or mp4) file may be very large which may result in long download times (>15 minutes, dependent upon computer speed). Because these video files may be very large (> 1GB), it is recommended that the user have a large external hard drive to store the data files. However, when using EVADE, the user would want to copy any files for investigation from the external hard drive to a working directory on the main drive in the computer.

For organizational purposes, it is important to save the dust concentration data file and the video camera file to a common directory. For example, if you are downloading the data files from sampling a mechanic, all the csv and avi (or mp4) files could be saved to a directory labeled \mechanic\. If the mechanic occupation was sampled at several different sites, the directories should indicate this. For example, \Minesite #1\mechanic\ would contain all the data files from sampling a mechanic at Minesite #1. Also, a naming convention for the data files should be adopted by the user to help describe and organize the csv and avi (or mp4) files.

Once the data files have been saved, the dust exposure analysis using EVADE can be conducted. The instructions for using the EVADE software are provided in Appendix A and will allow the user to use EVADE to conduct a dust exposure analysis.




[bookmark: _Toc327255125][bookmark: _Toc376936709][bookmark: _Toc386204203][bookmark: _Toc390083219]An Example: Conducting a New Dust Exposure Analysis

The EVADE software program is used to determine sources of overexposure to respirable dust. Once all of the different worker occupation video and dust concentration data files are downloaded and placed in their respective directories, the EVADE project analysis can be set up for viewing and subsequent evaluation. The following are guidelines for conducting a dust exposure analysis. The EVADE software instructions in Appendix A allow you to use EVADE which is an important tool for conducting the analysis. Each mine site’s needs are different, and you may use a methodology that may differ from these guidelines, but satisfy the needs of your site.

Once the user has the dust concentration data for each occupation, the overall time-weighted average (TWA) dust concentration should be recorded and ranked for each occupation. Dust exposure analysis should be conducted, first, on occupations which have the higher TWA dust concentrations. The user can determine if an occupation’s ranking will be based on gravimetric sampling or on real-time sampling. If filters were used to obtain a gravimetric sample, they should be sent for silica analysis, although it is not required. The silica analysis would aid in determining source exposure for respirable silica dust.

Documenting the overall TWA dust concentration will aid the user in determining the overall exposure for each occupation and determining the order of analysis based upon ranking of concentrations. Table 1 shows an example of documenting TWA concentrations for each occupation from a Helmet-CAM survey conducted on a blast crew at a surface mine site.

[bookmark: _Toc390083666]Table 1. Dust concentrations from Helmet-CAM study of blast crew

		Job Description

		Gravimetric
Concentration
(mg/m3)

		pDR
Concentration
(mg/m3)

		Calibration Ratio

		Sampling
Time Period
(minutes)

		%
Quartz



		Blaster 2

		0.179

		0.235

		0.761

		193

		11



		Stemmer

		0.101

		0.051

		1.971

		189

		12



		Blaster 1

		0.079

		0.108

		0.661

		182

		26





In some cases the TWA dust concentrations may be very low. However, this does not preclude the existence of spikes of high respirable dust concentrations during the sampling period. These spikes will be the targets that the user exploits for source determination.

The user then sets up a new dust exposure analysis for an occupation through the File menu in the EVADE program after which the analysis is ready to commence. At this point, the main program window shows the video display and the dust concentration graph (Figure 6).
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[bookmark: _Ref370899171][bookmark: _Toc390083716]Figure 6. The EVADE main window after either the New Project or Open command under the 
File menu are selected to set up a new dust exposure analysis.

An initial step after setting up an EVADE occupation analysis, is to create thresholds that will aid the user in source identification. These thresholds may be the legal limit for respirable dust or may be some other user-defined limit. The number of thresholds to use can be determined by the user. The threshold(s) can be used as a guide to show dust concentrations that are of concern.

If the Helmet-CAM surveys were conducted in conjunction with gravimetric samplers, the calibration ratio should be used to adjust the dust concentrations from the light-scattering dust sampling instruments. The use of the calibration ratio will allow for comparison of dust concentrations across all occupations to help determine which occupations are more susceptible to respirable dust overexposure.

The user then proceeds viewing the playback of the video and dust concentration graph. The user can first target the highest spikes in respirable dust concentrations, which generally represent a specific activity being conducted by the occupation. EVADE automatically bookmarks the five highest concentration spikes. The software uses an algorithm that allows it to identify separate peaks, while attempting to prevent clustering of the five bookmarks around a single peak. The user can proceed to these bookmarks to identify the exposure sources through the video. The user can then proceed to other additional peaks creating additional bookmarks to identify other sources from occupation activities by bookmarking them in EVADE.

Selecting the Export Bookmarks command (from the File menu) and the Screenshot command (from the View menu) will allow the user to document the sources of respirable dust overexposure for the occupation. The Export Bookmarks command will save the bookmarks as a csv file which can be imported into a spreadsheet, allowing the bookmarks to be edited to create tables. Table 2 is an example of a table created using data from the Export Bookmarks command that documents potential respirable dust exposure sources. The Screenshot command exports the current view of the EVADE software to a jpg file which can also be used to document potential respirable dust exposure sources.

[bookmark: _Ref305674619][bookmark: _Toc390083667]Table 2. EVADE automatic and user-defined bookmarks showing times, concentrations, and job activities for Blaster 1

		Bookmark #

		Bookmark Type

		Time1
(hh:mm:ss)

		Concentration (mg/m3)

		Job Activity



		1

		Automatic

		01:16:30

		5.620

		Loading hole w/ANFO2



		2

		Automatic

		01:05:18

		2.054

		Loading hole w/detonator



		3

		Automatic

		01:19:22

		1.974

		Loading hole w/ ANFO



		4

		Automatic

		01:05:22

		1.968

		Loading hole w/detonator



		5

		Automatic

		01:27:56

		1.948

		Cleaning hardhat



		6

		User-defined

		00:25:09

		1.836

		Loading hole w/ANFO



		7

		User-defined

		00:08:38

		0.581

		Kicking material downhole for double decking



		8

		User-defined

		00:11:05

		0.632

		Kicking material downhole for double decking 



		9

		User-defined

		00:29:02

		0.791

		Loading hole w/ANFO



		10

		User-defined

		00:31:28

		0.947

		Loading hole w/ANFO



		11

		User-defined

		02:52:44

		1.754

		Backing ANFO truck out of blast area



		12

		User-defined

		01:20:37

		1.658

		Loading hole w/ANFO



		13

		User-defined

		01:21:52

		1.551

		Loading hole w/ANFO



		14

		User-defined

		01:18:20

		1.698

		Loading hole w/ANFO



		15

		User-defined

		01:26:14

		0.713

		Stemming w/foot



		16

		User-defined

		01:38:15

		0.414

		Drop explosive box in dust



		17

		User-defined

		01:28:41

		0.625

		Clean hardhat



		18

		User-defined

		00:43:12

		0.808

		Load hole w/ANFO





1Time represents elapsed time of the video where bookmark occurs.

2ANFO –Ammonium nitrate and fuel oil.

The number of bookmarks to create identifying respirable dust exposure sources is dependent upon the user’s needs. Once sources are identified, engineering controls or work behaviors can be developed or modified to eliminate exposure from the source. EVADE will help in the development of these controls or behaviors by allowing the user to view the source of exposure by allowing repeat or pause of the video as many times as desired.

EVADE can also be used as a training tool to show workers the sources of their overexposure to respirable dust. Playback of the EVADE program can be conducted with the worker to highlight areas where overexposures occurred while daily tasks were performed. The video can demonstrate what duties the worker was performing while the dust concentration data shows the levels of respirable dust to which the miner was exposed. Additionally, EVADE can also be used in a safety meeting setting to show exposure sources to the entire work crew. It is recommended that you, as the user of this software program, review the video and data files prior to presenting the information at a safety meeting. As you gain experience working with the software, you may find additional novel techniques for finding respirable dust exposure sources for different mining occupations. Additionally, you may find other beneficial uses for the EVADE software. Ultimately, you and other users of the software will find that EVADE is an important tool in preventing respirable dust exposures in the mining industry.
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[bookmark: _Toc390083223]Instructions for Using the EVADE Software Version 1.0
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The files required for the installation of EVADE are located on the enclosed CD or can be downloaded from the NIOSH OMSHR website. An Installation Wizard will allow you to easily install EVADE on your computer. After installing EVADE, a video codec may have to be installed to view the video files if the video does not playback. If codec installation is required, follow the instructions in the Installing the DIVX Codec section in this document.

NOTE: Administrative rights may be required to install the software.

To install the EVADE software, perform the following steps:

1. Insert the EVADE software CD into your computer’s CD drive or download the software from the EVADE website.

2. Start Windows Explorer to browse the contents of the CD.

3. Double-click on the Setup.exe icon: [image: ]

The .NET framework is required for EVADE. If it is not already installed, the setup program will automatically install it. A dialog box will appear for .NET framework installation and should proceed without requiring user intervention.

4. The initial installation window appears (Figure 7). This is the Setup Wizard which will guide you through the installation process.
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[bookmark: _Ref303600299][bookmark: _Toc327255138][bookmark: _Toc390083717]Figure 7. The initial installation window for EVADE.

5. Once this installation window appears, click Next.

6. A window with the Disclaimer of Liability Clause will appear for you to read (Figure 8). (The text of the Disclaimer is shown in italics below Figure 8).

If you agree with the Disclaimer, check the I have read and accept this disclaimer selection, and click Next to proceed. A print option is available if you want to print out the Disclaimer text.
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[bookmark: _Ref353866875][bookmark: _Toc390083718]Figure 8. Window displaying NIOSH Disclaimer.

Disclaimer of Liability

This NIOSH/OMSHR developed software is provided “AS IS” without warranty of any kind including express or implied warranties of merchantability or fitness for a particular purpose. By acceptance and use of this software, which is conveyed to the user without consideration by NIOSH, the user expressly waives any and all claims for damage and /or suits for personal injury or property damage resulting from any direct, indirect, incidental special or consequential damages, or damages for loss of profits, revenue, data or property use, incurred by the user or any third party, whether in an action in contract or tort, arising from access to, or use of, this software in whole or in part.

No further development or upgrades for this software is planned. Any questions concerning this product can be directed to the Office of Mine Safety and Health Research email box at <mail to:OMSHR@cdc.gov>

7. The wizard will display the folder where EVADE will be installed (Figure 9). If this directory is satisfactory, click Next to proceed.
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[bookmark: _Ref353866825][bookmark: _Toc390083719]Figure 9. Window displaying folder where EVADE will be installed.

If you prefer a different directory, click Change to open another window which will allow you to select the folder where you want EVADE to be installed (Figure 10).
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[bookmark: _Ref325710334][bookmark: _Toc327255141][bookmark: _Toc390083720]Figure 10. Window displaying dialog box where you select the installation folder.

Using this window, you can either type the desired installation folder or select the desired installation folder. Click Next after making the desired selection.

8. The next window notifies you that the program is ready for installation (Figure 11).

[image: ]

[bookmark: _Ref303600702][bookmark: _Toc327255142][bookmark: _Toc390083721]Figure 11. Confirm installation window.

9. Click Install to proceed with the installation. As the installation proceeds, a window is displayed which contains a bar showing the progress of the installation (Figure 12).
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[bookmark: _Ref303600732][bookmark: _Toc327255143][bookmark: _Toc390083722]Figure 12. Installation progress window.

10. Once the installation is complete, a window will appear notifying you that the installation was successful (Figure 13). A check box is automatically selected to create an EVADE shortcut on the desktop. Deselect the check box if you do not want a shortcut created on the desktop.

[image: ]

[bookmark: _Ref303600748][bookmark: _Toc327255144][bookmark: _Toc390083723]Figure 13. Installation complete window.

11. Click Finish to exit the installation wizard.

12. The EVADE program is ready for use. An EVADE icon [[image: ] ] is optionally placed on the Windows desktop, enabling you to easily start the program.

13. EVADE can also be started from the Start menu by selecting All Programs/NIOSH/EVADE and then selecting EVADE (Figure 14).
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[bookmark: _Ref355015433][bookmark: _Toc355018391][bookmark: _Toc390083724]Figure 14. The Start menu showing the location of the EVADE software, User’s Manual, 
Quick Start Guide, and EVADE Demo Video.

Clicking EVADE starts the EVADE software. While clicking the EVADE User’s Manual and EVADE Quick Start Guide, open each file in Adobe Acrobat reader, respectively.

Also included is an EVADE Demo Video (without sound) that can be viewed and which presents to the user (by following the mouse cursor) the basic operation and playback features of EVADE. This video is started by clicking the EVADE Demo Video.

An example video file and respirable dust concentration data file are available for testing the EVADE software. They are included on the CD in the \ExampleData\ directory or are available from the EVADE website.

[bookmark: _Toc327255092][bookmark: _Toc376936714][bookmark: _Toc386204208][bookmark: _Toc390083225]Removing the EVADE Software Program

If you want to remove EVADE from your computer, there are two methods to accomplish this task:

· One method is to proceed to the Window’s Control Panel and select the command which enables you to uninstall, change, or repair software programs. Click on EVADE in the list of programs to remove the EVADE software from the computer.

· The other method is to use EVADE’s software removal tool. This is accomplished by reinserting the CD and double-clicking the Setup.exe icon on the CD. The setup wizard will automatically detect if EVADE is on the computer and provide three options: Modify, Repair, or Remove. The Remove option will remove the EVADE software from the computer. Select the Remove all installed features option and click Next to complete the removal of the EVADE software from your computer (Figure 15).
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[bookmark: _Ref303600852][bookmark: _Toc327255145][bookmark: _Toc390083725]Figure 15. Window showing the Modify, Repair, and Remove options for EVADE.

[bookmark: _Toc376936715][bookmark: _Toc386204209][bookmark: _Toc390083226]Repairing the EVADE Software Program

The Repair option (Figure 15) is used if you encounter problems operating EVADE; this option will complete a re-installation in an attempt to repair the program.

[bookmark: _Toc376936716][bookmark: _Toc386204210][bookmark: _Toc390083227]Modifying the EVADE Software Program

The Modify option is currently not enabled. This option would normally be used to install or remove program features. This feature will be used in future program updates.

[bookmark: _Toc327255093][bookmark: _Toc376936717][bookmark: _Toc386204211][bookmark: _Toc390083228]Installing the Video Codec

To view the video files in EVADE, you will also have to install the DIVX codec on your computer. This codec can be found on the installation disk provided by V.I.O. for the POV cameras, or can be downloaded and installed from the DIVX website: http://www.divx.com/en/software/divx-plus/codec-pack. Follow the instructions listed on the website to use this codec.

[bookmark: _Toc327255094][bookmark: _Toc376936718][bookmark: _Toc386204212][bookmark: _Toc390083229]Another codec which seems to work better with EVADE, providing better video playback, is the XVID codec, which can be downloaded from the website: http://www.xvid.org. 

Overview of the EVADE  Main Window

To start the EVADE program:

1. Double-click on the EVADE shortcut icon [[image: ]] located on the Windows Desktop or go to the Start menu and select All Programs/NIOSH/EVADE and select the EVADE icon.

2. EVADE will start by displaying the main window of the program (Figure 16).

The window may open in a minimized mode. You can change the default window size. Upon opening the program, change the window to the desired size. Exit EVADE and then restart. EVADE will remember the last window size display and use it for the default size on the next startup.
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[bookmark: _Ref303601897][bookmark: _Toc327255146][bookmark: _Toc390083726]Figure 16. The main window of the EVADE program.




The EVADE main window contains the following elements:

· The active title bar at the top of the window contains the name of the software program, EVADE, on the left and the standard Minimize, Restore Down/Maximize, and Exit buttons that are familiar with typical windows programs on the right.

· Right below the active title bar is the menu bar, which contains a series of drop-down menus: File, Bookmarks, Playback, View, and Help. Clicking on any one of these menu names opens a drop-down menu with commands for operating the program.

· The display areas for the dust exposure analysis consist of two open areas. The large gray area on the right is the video display area. The large white area underneath the title Reading: 0.00 is where the dust data graph will display when an analysis through EVADE is begun.

· On the left below the menu bar are the following menu tabs: Details, Active Bookmarks, Active Files, and Notes. Clicking on any of these tabs will display different information in the subwindow just beneath the tabs.

· Below the menu tabs area is a Zoom bar which can be used to zoom in and out on the dust data graph during analysis.

· Below the Zoom bar are the following action buttons: Open File, New Project, Play, Pause, Stop, and Audio On/Audio Off (Mute) if audio is used.

[bookmark: _Toc327255096][bookmark: _Toc376936719][bookmark: _Toc386204213][bookmark: _Toc390083230]Menu Bar Commands

The menu bar consists of the following menus: File, Bookmarks, Playback, View, and Help. Clicking on each menu name opens a drop-down menu which allows you to set up and operate the EVADE program for dust exposure analysis. The following sections describe each menu and its commands.

[bookmark: _Toc327255097][bookmark: _Toc376936720][bookmark: _Toc386204214][bookmark: _Toc390083231]File Menu

The File menu contains program commands that are used to initiate the dust exposure analysis. Click on File to open a drop-down menu listing the following commands (shown in Figure 17):

· Open (Ctrl+O)

· New Project (Ctrl+N)

· Export Bookmarks (Ctrl+E)

· Exit

In parenthesis next to each command are the keystrokes that can also be used to start the command. Once a File command has been used to set up the initial analysis, the commands in the Bookmarks, Playback, and View menus can be used. The commands in the Help menu can be used at any time to view Help topics for EVADE.

During the initial use of EVADE for a Helmet-CAM project, you will first select the New Project command to set up the analysis, defining the proper video and dust concentration data files to use in the respirable dust exposure analysis. Select the Open command to open existing analyses where these files are already established.

At the initial startup of the EVADE software, it will create a directory labeled EVADE in the My Documents folder of the computer. This EVADE directory will contain data files used by EVADE for software operation. The default directory location where the program dcf files, where dcf stands for dust camera file, will be stored will be the user selected directory containing the video and dust concentration data files. This EVADE directory is the location where dcf files will be automatically saved, unless otherwise specified. You have the option to select other directories as needed for the opening and saving of dcf files.

NOTE: Setting up EVADE to use data files from a CD, DVD, or network drive is not recommended. Because the video files are usually very large, file access errors may occur, and the EVADE program may not operate correctly during operation. It is best to set up the data files from your computer’s C:\ drive or any drive that has high speed read/write access.
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[bookmark: _Ref303602375][bookmark: _Toc327255147][bookmark: _Toc390083727]Figure 17. The File drop-down menu displaying available commands.

[bookmark: _Toc327255098][bookmark: _Toc376936721][bookmark: _Toc386204215][bookmark: _Toc390083232]Open Command

The Open command is used to open an existing dust exposure analysis.

To open an existing analysis:

1. Click on the Open option from the File menu to open the Open dialog box (Figure 18). This dialog box lists the filenames of existing dust exposure analyses and allows you to select the existing analysis file you want to open. The analysis file has the naming format of <filename>.dcf . This file is created during the configuration of an initial analysis under the New Project command. Therefore, these files will not be available during the initial setup. There is only one file created for a configured dust exposure analysis. You can create additional analyses for the same occupation by renaming the dcf file.
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[bookmark: _Ref303602049][bookmark: _Toc327255148][bookmark: _Toc390083728]Figure 18. The Open command dialog box.

2. Find the proper directory where the dust exposure analysis is stored.

3. Click on the desired filename of the dust exposure analysis you want to open, then click Open. The EVADE main window will update to display the video in the video display area and the dust concentration data graph (Figure 19).
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[bookmark: _Ref362435768][bookmark: _Toc390083729]Figure 19. The EVADE main window after an existing dust exposure analysis is selected 
through the Open command.

[bookmark: _Toc376936722][bookmark: _Toc386204216][bookmark: _Toc390083233]Possible Error Messages When Using the Open Command:

If there are possible problems with the data, a data file information message will be displayed to inform you of possible errors. Two common types of errors encountered are negative values and missing values (Figure 20).
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[bookmark: _Ref303603341][bookmark: _Toc327255150][bookmark: _Toc390083730]Figure 20. Data file information alert for negative values and missing values.

Negative values may occur due to faulty calibration of the real-time datalogging aerosol monitor. When encountered, the data is not changed by the program. The negative value alert is aerosol monitor specific. The alert will identify the real-time datalogging aerosol monitor based upon the data format encountered, i.e., if the data format is pDR-1500, then the alert mentions pDR-1500; if the data format is pDR-1000, then the alert mentions pDR-1000; if the data format is AM-510, then the alert mentions AM-510; and if the data format is EVADE’s universal format, then the alert mentions the type of real-time datalogging aerosol monitor that was input in the universal format dialog box. Missing values, another type of error, in the data file are identified as bad characters by EVADE. If there are missing values, the program substitutes a value that is the average of the previous and subsequent values surrounding the missing value. However, data in the dust concentration data file are not changed.

Another possible error that can occur is when the video and dust concentration time lengths are offset (Figure 21). A data file information alert informs the user that there is a difference between the length of time of the video file and of the dust concentration file. The program notifies the user of the time differential, but does not adjust for it.

NOTE: It is very important to start the real-time datalogging aerosol monitor and the video camera at the same time. EVADE cannot detect nor correct for any time differential due to differing startup times.
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[bookmark: _Ref303603716][bookmark: _Toc327255151][bookmark: _Toc390083731]Figure 21. Data file information alert for time differential between video and 
dust concentration files.

Clicking OK in any of the data file information boxes will clear the alerts. Once the window updates, the EVADE program will allow you to proceed with the dust exposure analysis. These data file information dialog boxes are informational windows only, and do not initiate corrections to be made by EVADE. To correct these errors, the user must physically edit the data files. As long as the video and dust sampling devices were started simultaneously and there is not a large number of negative values, editing the data files is not required and the dust exposure analysis can be conducted without any adverse impact from these errors.

There is the possibility that the video file may be corrupt due to disk read/write errors, multiple copying, etc., causing the video to not display in EVADE. In this case, a Video Load Error! will occur notifying you that the file is corrupt (Figure 22). EVADE will ask if you want to delete the dcf file to prevent the corrupt video file from being used in any dust exposure analysis. It is generally recommended to delete the dcf file and restart the dust exposure analysis anew. However, if a backup of the video file is available, the backup video file can be copied over the corrupt video file which should correct the Video Load Error. In this case, you would want to select No to deleting the dcf file when the Video Load Error! dialog box appears.
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[bookmark: _Ref362365155][bookmark: _Toc390083732]Figure 22. A Video Load Error! dialog box that appears during the Open command 
if the video file is corrupt.

[bookmark: _Toc327255099][bookmark: _Toc376936723][bookmark: _Toc386204217][bookmark: _Toc390083234]New Project Command

The New Project command is used to create a new dust exposure analysis. The data files that are used by EVADE are as follows:

<filename>.csv	Dust concentration data file. Created by the pDR-1000, pDR-1500, or AM-510.

<filename>.avi	A standard definition video file.

<filename>.mp4	A high definition video file. Currently, only Microsoft video formats are supported by EVADE. The software program will not work with Apple video formats.

<filename>.wmv	A Windows media video file. This format can also be read by EVADE. If problems viewing the avi video file occur during operation of EVADE, the video file can be converted to the wmv format.

<filename>.bmk	EVADE bookmark file. Created by EVADE during previous review of dust concentration and video files. This file contains the bookmarks automatically created by EVADE and any user-defined bookmarks.

These files are downloaded from the real-time datalogging aerosol monitor and video camera and should be placed in a common directory where they can be selected by EVADE. It should be noted that the bookmark file is created after the initial dust exposure analysis setup of the data files using EVADE. It will not be available during the initial setup of the analysis.

The user should ensure that the video (avi, mp4, or wmv) and dust concentration data (csv) files are located in the same directory because EVADE will not allow the setup procedure if only one type of file is in the directory. Additionally, once bookmark files have been created, the user should ensure that they are located in the same directory with the avi and csv data files in order to access the bookmarks during later dust exposure analysis.




To start a new dust exposure analysis:

1. Click on the New Project option from the File menu to open the Create New EVADE Project dialog box which is used to locate and associate the video, datalog, and bookmark files required to conduct a new dust exposure analysis (Figure 23). This dialog box contains three selection buttons, Select video file…, Select datalog file…, and (Optional) Select bookmark file…, each of which prompts the user for a specific action. The user is guided through the selection process via highlighted selection buttons. For example, in Figure 23 the user is prompted to select a video file, which is the first step. Clicking Cancel terminates the Create New EVADE Project process.
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[bookmark: _Ref303682040][bookmark: _Toc327255152][bookmark: _Toc390083733]Figure 23. The Create New EVADE Project dialog box which opens when the New Project command is selected from the File menu.




2. Click the Select video file…, the first highlighted selection button, to launch an Open dialog box (Figure 24). This dialog box allows selection of the video files in avi, mp4, or wmv format. The location of these video files can be selected by scrolling through the file listing on the left side of the dialog box and selecting the desired directory. The data can be located in a directory on any drive: for example, C:\ drive, CD rom drive, network drive, etc. It should be noted that poor video playback may occur in the EVADE software when the data is located on a network drive. EVADE will provide a notification of this circumstance (Figure 25); click OK to clear the message. Once the video file is selected, click Open to proceed. The next step Select datalog file will be highlighted. Selecting Cancel terminates the Select video file process and returns the user to the beginning of the Create New EVADE Project procedure.
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[bookmark: _Ref303693253][bookmark: _Toc327255153][bookmark: _Toc390083734]Figure 24. The New Project command dialog box showing drive directories.
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[bookmark: _Ref375143012][bookmark: _Toc390083735]Figure 25. The warning message notifying the user that EVADE video playback may be unsatisfactory when running data files from a network drive.




3. Click the Select datalog file… button to open the Select Datalog (CSV) File dialog box (Figure 26). This dialog box allows selection of the dust concentration data to be used by EVADE. The available dust concentration files, in csv format, are listed in this dialog box. Once the proper csv file is selected, click Select to proceed. Selecting Cancel terminates the Select datalog file procedure. The next step (Optional) Select bookmark file will be highlighted.

NOTE: This dialog box does not allow for switching directories. It uses the directory chosen during the video selection process. Therefore, it is important to keep all video and dust concentration data files in the same directory.
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[bookmark: _Ref303694060][bookmark: _Toc327255154][bookmark: _Toc390083736]Figure 26. The Select Datalog (CSV) File dialog box allowing selection of the 
dust concentration data file.




4. Click the (Optional) Select bookmark file… button to open the Select Bookmark (BMK) File dialog box (Figure 27). This dialog box allows selection of the bookmark file. A bookmark file, a filename with a bmk extension, is a file that contains bookmarks from a previously conducted dust exposure analysis. The initial project setup may not have an available bookmark file. Therefore, this is an optional command and selecting this command may not be required if there is no bookmark file or if the user decides not to use any existing bookmark files. As with the Select Datalog file step, this dialog box does not allow for switching directories. It uses the directory chosen during the video selection process. Click Select to proceed. Selecting Cancel terminates the Select bookmark file procedure.
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[bookmark: _Ref375314713][bookmark: _Toc390083737]Figure 27. The (Optional) Select Bookmark (BMK) File dialog box allowing selection 
of a bookmark file.




5. Once these steps are completed, the Create Project button becomes highlighted (Figure 28). At this time, if you notice a mistake in selecting a data file, you can go to any of the previous steps, (Optional) Select bookmark file, Select datalog file, or Select video file, and click on the appropriate button to reselect the data file.

NOTE: Selecting Select video file will start the entire file selection process over. Click on Create Project to proceed.
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[bookmark: _Ref375314861][bookmark: _Toc390083738]Figure 28. The Create New EVADE Project dialog box after all data file selections 
have been completed.




6. After selecting Create Project, a Save As dialog box will open allowing you to save the project (Figure 29). NOTE: To prevent overwriting the dcf files, the filename will be changed to <filename_v1>.dcf. With subsequent saves, _v1 will automatically increase as follows: _v1, _v2,_v3, etc. The user always has the option to rename the file. Once Save is selected, the window will update to display the video and dust concentration graph in the EVADE main window. Once the window updates, the EVADE program is ready to be used to conduct the dust exposure analysis.
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[bookmark: _Ref375318516][bookmark: _Toc390083739]Figure 29. The Save As dialog box displayed after selecting Create Project.

[bookmark: _Toc376936724][bookmark: _Toc386204218][bookmark: _Toc390083235]Possible Error Messages When Using the New Project Command:

As with the Open command, when using the New Project command data file information messages may display to inform the user of possible problems with the data. Two types of errors commonly encountered are negative values and missing values (Figure 20). If negative values occur, a data file information message will be displayed to alert you to their presence. When negative values are encountered due to faulty calibration of the real-time datalogging aerosol monitor, the data is not changed by the program.

If there are missing values, you are alerted with a data file information message and the program substitutes a value that is the average of the previous and subsequent value surrounding the missing value. However, data in the dust concentration data file are not changed.

 Another possible type of error that can occur is that the video and dust concentration time lengths are offset (Figure 21). A data file information alert informs you that there is a difference between the length of time of the video file and of the dust concentration file. The program notifies you of the time differential, but does not adjust for it. NOTE: It is very important to start the real-time datalogging aerosol monitor and the video camera at the same time. EVADE cannot detect nor correct for any time differential due to differing startup times.

Click the OK button in the dialog boxes to clear the data file information alerts. Once the window updates, the EVADE program will allow you to proceed with the dust exposure analysis.

There is the possibility that the video file may be corrupt due to disk read/write errors, multiple copying, etc. causing the video to not display in EVADE. In this case, a Video Load Error! will occur notifying you that the file is corrupt (Figure 30). EVADE will not create a dcf file. Click “Ok” to clear the error and to start over with the New Project command.
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[bookmark: _Ref362365274][bookmark: _Toc390083740]Figure 30. A Video Load Error! dialog box that appears during the New Project command 
if the video file is corrupt.

[bookmark: _Toc327255100][bookmark: _Toc376936725][bookmark: _Toc386204219][bookmark: _Toc390083236]Export Bookmarks Command

The Export Bookmarks command allows you to export the bookmark information that has been created during an EVADE analysis. This command allows conversion of the bmk file to a csv file which can be used in a written report. A bookmark is a link to an individual dust exposure event during the respirable sampling time period of the Helmet-CAM survey. EVADE creates five automatic bookmarks at the five highest dust concentration peaks in the data file. You can create additional bookmarks for other dust exposure events (see the Bookmarks Menu section for further information).

To export bookmark information:

1. Click on the Export Bookmarks option from the File menu or use the Ctrl+E keystrokes to display the Save As dialog box for saving the bookmarks (Figure 31). The default filename will be the name used for the bmk file with the added _EXP after the filename, but before the bmk extension. You have the option to rename the file and place it in a location of your choice.
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[bookmark: _Ref315685774][bookmark: _Toc327255156][bookmark: _Toc390083741]Figure 31. The Save as dialog box for saving the exported bookmark file. This example also shows the active bookmarks under the Active Bookmarks tab.

2. The exported bookmark file will be saved as a comma delimited file (.csv) which can be viewed in Excel or WordPad/Notepad. The file will have the following data columns (which correspond to the information that can be viewed through the Active Bookmarks tab):

Bookmark #. The number that corresponds to the bookmark number in EVADE.

Name. The user defined name of the bookmark or the label Max 1 through Max 5 if an automatic bookmark.

Time (hh:mm:ss). The time that the bookmark occurs in the video file.

Concentration (micrograms, milligrams, % concentration, or ppm). The dust concentration value associated with the bookmark

An example of a typical exported bookmark file is shown in Table 3. The first row is the title row with the column titles. Each row thereafter corresponds to a bookmark and displays the columnar information, which corresponds with the Active Bookmark Tab columns, associated with that bookmark. Name corresponds with Description, and Concentration corresponds with Reading. The first five data rows will contain information for the five automatic bookmarks, which will be named Max 1 through Max 5. Time will always be in hh:mm:ss and Concentration may be micrograms or milligrams, depending on the units selected.




[bookmark: _Ref315686330][bookmark: _Toc390083668]Table 3. Example of exported bookmark data using the Export Bookmarks command

		Bookmark #

		Name1

		Time (hh:mm:ss)

		Concentration2
(µm, micrograms)



		1

		Max1

		01:14:16

		4,456



		2

		Max2

		00:33:12

		1,992



		3

		Max3

		00:33:20

		2,000



		4

		Max4

		01:17:26

		4,646



		5

		Max5

		00:33:16

		1,996



		6

		stemming3

		00:17:37

		1,057



		7

		stemming

		00:18:35

		1,115



		8

		stemming

		00:20:54

		1,254



		9

		stemming

		00:21:40

		1,300



		10

		stemming

		00:34:33

		2,073



		11

		stemming

		00:35:19

		2,119



		12

		stemming

		00:48:33

		2,913



		13

		stemming

		00:50:40

		3,040



		14

		stemming

		00:55:24

		3,324



		15

		stemming

		01:00:00

		3,600



		16

		trk rev4

		01:20:23

		4,823



		17

		revtrkincab5

		01:20:57

		4,857



		18

		stemming

		01:25:16

		5,116



		19

		stemming

		01:28:22

		5,302



		20

		stemming

		01:31:52

		5,512





[bookmark: _Toc327255101][bookmark: _Toc376936726][bookmark: _Toc386204220]1 Name corresponds with Description on the Active Bookmarks Tab

2 Concentration corresponds with Reading on the Active Bookmarks Tab

3 stemming refers to the job activity of filling the blasthole with stemming material

4 trk rev refers to increasing the truck engine rpm when operating

5 revtrkincab refers to backing up the bulk truck while operator is in cab with window open

[bookmark: _Toc390083237]Exit Command

Clicking the Exit command option from the File menu allows you to exit the EVADE program.

[bookmark: _Toc327255102][bookmark: _Toc376936727][bookmark: _Toc386204221][bookmark: _Toc390083238]Bookmarks Menu

A bookmark is a link to an individual dust exposure event during the respirable sampling time period of the Helmet-CAM survey. The Bookmarks menu allows you to add bookmarks as needed. The added bookmarks are user-defined bookmarks. EVADE creates five automatic bookmarks at the five highest dust concentration peaks in the data file. The Bookmarks menu 


allows you to turn on and off these five automatic bookmarks created by EVADE. Click on Bookmarks on the menu bar to open a drop-down menu which contains the following commands (Figure 32):

· Add (Ctrl+B)

· On/Off Max Bookmarks
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[bookmark: _Ref303768931][bookmark: _Toc327255157][bookmark: _Toc390083742]Figure 32. The Bookmarks drop-down menu (upper left) with available commands.

[bookmark: _Toc327255103][bookmark: _Toc376936728][bookmark: _Toc386204222][bookmark: _Toc390083239]Add Command

The Add command from the Bookmarks menu allows the creation of bookmarks on the dust concentration graph. A bookmark can be used to mark a position on the graph to which you can refer at a later time during the dust exposure analysis. The bookmarks added through the Add command are user-defined bookmarks.

To add a bookmark:

1. Do one of the following to select the position on the dust concentration graph where you want to add the bookmark:

NOTE: The vertical green line on the graph represents the location on the graph that corresponds to the picture displayed on the video screen.

· Allow the dust concentration graph to move or playback to the desired position during playback.

· Drag the dust concentration graph to the desired location using the mouse. To do this, left-click on the graph, then drag the graph in the desired direction.

· Use the slider bar, located right above the graph, to adjust the display of the dust concentration graph.

2. Once the vertical green line is at the desired location for the bookmark, click Add from the File menu or use the keystrokes Ctrl+B. The Add Bookmark dialog box opens prompting for a bookmark description (Figure 33).

Note: Click Cancel to cancel the operation of creating a bookmark.
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[bookmark: _Ref303770674][bookmark: _Toc327255158][bookmark: _Toc390083743]Figure 33. The Add Bookmark dialog box.

3. Enter a name for the new bookmark in the Description box (12-character maximum) to identify the bookmark. Then, click OK to set the bookmark.

For example, typing a description such as “New Bookmark” in the Description box and clicking OK will add a new bookmark at the location of the vertical green line (Figure 34) and label that location “New Bookmark.” It will also number the bookmark with the next consecutive number (shown as Bookmark # 6 in the Active Bookmarks tab in Figure 34).

The program automatically marks 5 bookmarks for the first five highest dust concentrations from the dust concentration data file. The program allows a maximum of 50 bookmarks per dust exposure analysis.

4. In addition to automatically numbering the bookmark the EVADE program shows the new bookmark’s location in time format, Time (hr), (min), (sec).

5. Bookmarks are automatically saved in the dcf file when the EVADE program is exited and re-opened using the Open command from the File menu.

6. The new bookmark appears as the last bookmark in the tabs information area, which is displayed when the Active Bookmarks tab is selected (located in the upper left area of the window, as shown on Figure 34).

, [image: ]

[bookmark: _Ref303771274][bookmark: _Toc327255159][bookmark: _Toc390083744]Figure 34. The “New Bookmark” added to the dust concentration graph. This bookmark is also shown on the Active Bookmarks tabs on the left.

[bookmark: _Toc327255104][bookmark: _Toc376936729][bookmark: _Toc386204223][bookmark: _Toc390083240]On/Off Max Bookmarks Command

Selecting the On/Off Max Bookmarks command from the Bookmarks menu opens a submenu with On and Off commands. These commands allow you to turn on or turn off the five bookmarks that are automatically created by EVADE.

When the On/Off Max Bookmarks submenu opens, the On command is checkmarked. There will be five bookmarks located at the five maximum dust concentrations on the dust concentration graph.

Clicking the Off command places a checkmark by it, and the five automatic bookmarks will not be displayed in either the dust concentration graph or in the Active Bookmarks subwindow (Figure 35). The Off command will only turn off the five automatic maximum bookmarks. If there are any user-defined bookmarks, the user-defined bookmarks will still be available.

Clicking the On command places a checkmark by it, and the five automatic bookmarks will be restored on the dust concentration graph and in the Active Bookmarks tab (Figure 36). This allows the user to toggle on or off the display of the five automatic bookmarks.
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[bookmark: _Ref326329700][bookmark: _Toc327255160][bookmark: _Toc390083745]Figure 35. The On/Off Max Bookmarks command selected with the Off command checkmarked.
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[bookmark: _Ref326329519][bookmark: _Toc327255161][bookmark: _Toc390083746][bookmark: _Toc327255105]Figure 36. Display of the On/Off Max Bookmarks command with the On command checkmarked.

[bookmark: _Toc376936730][bookmark: _Toc386204224][bookmark: _Toc390083241]


Playback Menu

The Playback menu displays commands that can be used during the playback of the video and the dust concentration data graph. Click Playback on the menu bar to open a drop-down menu which contains the following commands (Figure 37):

· Play (Ctrl+P). Clicking Play or typing Ctrl and P starts playback of the video and the dust concentration graph. When you click on Play, the Pause and Stop commands become enabled.

· Pause (Ctrl+U). Clicking Pause or typing Ctrl and U pauses the playback of the video and dust concentration graph.

· Stop (Ctrl+S). Clicking Stop or typing Ctrl and S stops playback of the video and dust concentration graph, and resets the video and dust concentration graph to the beginning.

· Audio On/Off (Ctrl+A). Clicking Audio On/Off toggles between turning off the audio and turning on the audio, if the audio was enabled during recording.

NOTE: The left arrow and right arrow keys on the keyboard can also be used to progress through the video. Pressing either key will advance (using the right arrow key) or retreat (using the left arrow key) in approximately 10-second intervals each time the key is pressed. This advance and retreat can be accomplished during the Play, Pause, or Stop modes.
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[bookmark: _Ref303772947][bookmark: _Toc327255162][bookmark: _Toc390083747]Figure 37. The Playback drop-down menu (upper left) with available commands.

[bookmark: _Toc327255106][bookmark: _Toc376936731][bookmark: _Toc386204225][bookmark: _Toc390083242]View Menu

When you click on View from the menu bar, the View drop-down menu opens, listing the following commands (Figure 38):

· Screenshot (Ctrl+Q). Clicking on Screenshot or pressing the Ctrl and Q keys on your keyboard will allow you to take a snapshot of the current screen and save it as a JPEG file.

· Units. Clicking on Units opens a submenu and allows you to toggle between units of milligrams (mg/m3) or micrograms (µg/m3).

· Graph Options. Clicking on Graph Options opens the Graph Options dialog box where you can make changes to the dust concentration graphical display which appears at the bottom of the EVADE main window.

· Calibrate (Ctrl+L). Clicking on Calibrate or pressing the Ctrl and L keys on your keyboard will open the Calibrate dialog box where you can calibrate the dust concentrations using the user-defined calibration ratio which is used to correct data from light-scattering instruments.
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[bookmark: _Ref315687220][bookmark: _Toc327255163][bookmark: _Toc390083748]Figure 38. The View drop-down menu (upper left) with available commands.

[bookmark: _Toc327255107][bookmark: _Toc376936732][bookmark: _Toc386204226][bookmark: _Toc390083243]Screenshot

Clicking on Screenshot from the View menu or pressing the Ctrl and Q keys on your computer keyboard displays a Save As dialog box for saving the current screen snapshot (Figure 39). The default filename will be the name used for the avi file with a jpg extension. However, you have the option of renaming the file and placing it in a location of your choice.

The Save As dialog box automatically labels the filename with the default file name <filename>.jpg. In the example in Figure 39, the file name is Blaster 8_10_11_V1. To prevent overwriting previous screenshots, the default filename will be changed to <filename_v1>.jpg. With subsequent automatic saves, _v1 will increase as follows: _v1, _v2,_v3, etc. to differentiate the screenshot from other screenshots.

Once the file is saved, the user can then view the jpg file using Windows Picture and Fax Viewer or the file can be opened for viewing and editing with any jpg editing software (Figure 40). The Screenshot command is useful for generating illustrations for reports.
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[bookmark: _Ref315687312][bookmark: _Toc327255164][bookmark: _Toc390083749]Figure 39. The Save As dialog box that opens when the Screenshot command is selected 
from the View menu.
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[bookmark: _Ref326681747][bookmark: _Toc327255165][bookmark: _Toc390083750]Figure 40. Microsoft Windows Picture and Fax Viewer view of jpg file created 
by the Screenshot command.




[bookmark: _Toc327255108][bookmark: _Toc376936733][bookmark: _Toc386204227][bookmark: _Toc390083244]Units

Clicking on the Units command from the View menu opens a submenu displaying Milligrams and Micrograms (Figure 41). The program starts with the units that are standard with the real-time datalogging aerosol monitor being used (micrograms/m3 for pDR-1500, milligrams/m3 for pDR-1000 and AM-510). Clicking the other unit will convert the units in the different displays and for the dust concentration data graph. For example, if Micrograms was originally checked, clicking Milligrams converts all the dust concentrations to milligrams and vice versa.
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[bookmark: _Ref303776898][bookmark: _Toc327255166][bookmark: _Toc390083751]Figure 41. The Units submenu that opens when the Units command is selected 
from the View menu.

[bookmark: _Toc327255109][bookmark: _Toc376936734][bookmark: _Toc386204228][bookmark: _Toc390083245]Graph Options

Clicking on the Graph Options command from the View menu opens the Graph Options dialog box which contains features you select for the dust data graph that appears on the main window (Figure 42). This dialog box contains three main selection areas:

· Graph Scaling

· Thresholds

· Display Options

NOTE: Clicking on the Options button to the right of the Zoom bar also opens the Graph Options window.




Graph Scaling

This feature allows the user to set the vertical scale of the dust concentration graph by selecting one of the following options:

· Automatic Scaling to Full Data Set. This feature sets the vertical scale of the dust concentration data graph to the maximum dust concentration encountered in the entire dust concentration data file.

· Automatic Scaling to Visible Data. This feature sets the vertical scale of the dust concentration data graph to the maximum dust concentration that is currently viewable in the graphical area. This maximum may readjust to different values as the video and graph scroll through the data.

Manual Upper Limit. This feature allows the user to define the upper limit of the vertical scale of the dust concentration data graph in the unit displayed. You can use the up and down arrows of the number selection box to select the desired upper limit in 0.1 increments, or type the desired upper limit in the number selection box. The upper limits that can be entered are 800 for mg/m3, 800,000 for µg/m3, 1,000,000 for ppm, and 100 for % concentrate.
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[bookmark: _Ref326158144][bookmark: _Toc327255167][bookmark: _Toc390083752]Figure 42. The Graph Options dialog box that opens when selected from the View menu.

Thresholds

This feature allows you to input a horizontal line that represents a user-defined concentration limit in the dust concentration data graph. This can be useful when you want to view dust concentrations that may be above your thresholds for dust concentrations.

To add a threshold:

1. Click on the Add Threshold… button on the Graph Options dialog box. The Edit Threshold dialog box will open (Figure 43).

2. Enter a name for the new threshold in the Name text box.

3. Enter a user-defined threshold limit or select a limit (using the up and down arrows to increase or decrease the threshold in 0.1 increments) in the Threshold Value (µg/m3) text box. You must ensure that the threshold value is entered in units requested, either µg/m3 or mg/m3.
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[bookmark: _Ref326161659][bookmark: _Toc327255168][bookmark: _Toc390083753]Figure 43. The Edit Threshold dialog box that opens when you click on the 
Add Threshold button.

4. In the Color box, select the down arrow or just select the Color box to open the drop-down color selection dialog box, showing Available Colors and Standard Colors. Select a color for the threshold line (Figure 44).

Selecting the Advanced button on the color selection dialog box opens the advanced drop-down dialog box where you can use the slider bars for R, G, B, and A (R=red, G=green, B=blue, and A=opacity) to change the colors and opacity of the threshold line (Figure 45).
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[bookmark: _Ref326746495][bookmark: _Toc327255169][bookmark: _Toc390083754]Figure 44. The Edit Threshold dialog box showing the drop-down color selection box.
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[bookmark: _Ref326746512][bookmark: _Toc327255170][bookmark: _Toc390083755][bookmark: OLE_LINK1][bookmark: OLE_LINK2]Figure 45. The Edit Threshold dialog box showing the drop-down advanced 
color selection box.

5. In the Line Style box, select the down arrow or simply select the box to open a drop-down box containing six different line styles (Figure 46). Select one of the line styles, then click on the Ok button to create the threshold lines.
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[bookmark: _Ref326746469][bookmark: _Toc327255171][bookmark: _Toc390083756]Figure 46. The Edit Threshold dialog box showing the drop-down line style selection box.

6. Creating multiple thresholds. The user can also create additional thresholds which will be all displayed concurrently (Figure 47). There is no limit to the number of thresholds that can be created.

7. Deleting thresholds. The user can delete any or all of the thresholds by clicking on the red X button next to the threshold to be deleted (Figure 47). It should be noted that any thresholds created will remain active in other EVADE analyses, both when opening new dust cam files (dcf) or creating new analyses, until they are actually deleted.
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[bookmark: _Ref326746439][bookmark: _Toc327255172][bookmark: _Toc390083757]Figure 47. The Graph Options dialog box showing additional thresholds added to the graph.

Display Options

This feature contains three selection options for displaying information on the dust concentration data graph on the EVADE main window. These display options are on the upper right side of the Graph Options dialog box under Display Options and include:

· Show bookmarks

· Show thresholds

· Show grid lines

A checkbox beside each option allows you to display or hide the corresponding option. You can set your preferences by selecting or deselecting the following options (a checkmark in the checkbox indicates that the option is selected):

· Show bookmarks. When selected, this option will display all the bookmarks in the graph area. When deselected, all the bookmarks will be hidden. Note: the On/Off Max Bookmarks command under the Bookmarks menu will override this option. If On/Off Max Bookmarks is Off, then this option will not function.

· Show thresholds. When selected, this option will display all the user-defined thresholds. When deselected, all the thresholds will be hidden.

· Show grid lines. When selected, this option will display the background grid lines in the graph area. When deselected, the background grid lines will be hidden.

[bookmark: _Toc327255110][bookmark: _Toc376936735][bookmark: _Toc386204229][bookmark: _Toc390083246]Calibrate

Selecting Calibrate from the View menu allows you to select the calibration ratio which is used to correct light-scattering, dust-measuring devices such as the 1000-pDR or 1500-pDR for the characteristics of the dust type being measured. This procedure is recommended for all light-scattering instruments [Williams and Timko 1984]. Correction is accomplished using a gravimetric sampler along with the light-scattering instrument (the 1500-pDR has a built-in gravimetric) [Reed et al. 2012]. The sampling time period of the gravimetric and light-scattering instrument must be similar. The ratio is calculated using the following equation (also shown in the Sampling Procedure section):



where	Ratio = the calibration ratio;

Grav = the gravimetric time-weighted average (TWA) concentration; and

Instant = the real-time optical TWA concentration from the 1500-pDR.

Next, the calibration ratio is multiplied by each real-time optical concentration recorded by the 1000-pDR or 1500-pDR in order to obtain absolute concentrations which can be comparable to other concentrations.

To use the Calibration command:

1. Click on Calibrate in the View menu or type the keystrokes Ctrl and L. The Calibrate dialog box will open as shown in Figure 48.

2. Enter the calibration ratio in the box to the right of Calibration Ratio or select the calibration ratio by using the up and down arrows in the box. Each click of the up or down arrow will increase or decrease the calibration ratio by 0.01. The calibration ratio must be within a range of 0.01 to 100. The default calibration ratio is 1.00.

3. After entering the calibration ratio, click the OK button to activate the calibration. This action will multiply all the real-time dust concentrations by the calibration ratio. For example in Figure 48, the ratio entered is 1.15. Therefore, all the real-time dust concentrations will be multiplied by the ratio 1.15. The calibration will be reflected in the number field to the right of the Reading label above the graph and on the y-axis of the dust concentration graph.

4. To clear or reset the calibration ratio, click on the check box next to “Restore original data values.” Or, enter 1.00 in the calibration ratio.
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[bookmark: _Ref315684154][bookmark: _Toc327255173][bookmark: _Toc390083758]Figure 48. The Calibrate dialog box for entering the calibration ratio.

[bookmark: _Toc327255111][bookmark: _Toc376936736][bookmark: _Toc386204230][bookmark: _Toc390083247]Help Menu

When you click on Help from the menu bar, the Help drop-down menu opens, listing the following commands (Figure 49) that provide help and information about the EVADE software program:

· View Help. Clicking on View Help opens the EVADE Help Files window.

· View Playback Details. Clicking on View Playback Details opens an informational window displaying the active codecs.

· About. Clicking on About opens the EVADE program version dialog box.
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[bookmark: _Ref303779691][bookmark: _Toc327255174][bookmark: _Toc390083759]Figure 49. The Help drop-down menu with available commands.

[bookmark: _Toc376936737][bookmark: _Toc386204231][bookmark: _Toc390083248]View Help

Clicking on the View Help command from the Help menu opens the EVADE Help Files window where the user can find information about the EVADE program by browsing the topics listed in the column on the left (Figure 50). The user can search for information by browsing for information through the Contents tab, by using the Index through the Index tab, or by typing search keywords in the text box under the Search tab.
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[bookmark: _Ref326765862][bookmark: _Toc327255175][bookmark: _Toc390083760]Figure 50. Display of the Help window.

[bookmark: _Toc376936738][bookmark: _Toc386204232][bookmark: _Toc390083249]View Playback Details

Clicking on the View Playback Details command from the Help menu opens a window that displays information about the active codecs being used by the EVADE program (Figure 51).
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[bookmark: _Ref326766089][bookmark: _Toc327255176][bookmark: _Toc390083761]Figure 51. The Active Codecs dialog box which opens when Video Playback Details 
is selected from the Help menu.

[bookmark: _Toc376936739][bookmark: _Toc386204233][bookmark: _Toc390083250]About

Clicking on the About command from the Help menu opens a dialog box which provides information on the EVADE program version and displays the NIOSH disclaimer (Figure 52). Click OK to return to the EVADE program.
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[bookmark: _Ref303779854][bookmark: _Toc327255177][bookmark: _Toc390083762]Figure 52. The informational dialog box that opens when About is selected from the Help menu.




[bookmark: _Toc327255112][bookmark: _Toc376936740][bookmark: _Toc386204234][bookmark: _Toc390083251]Menu Tabs

The menu tabs are located just below the menu bar in the upper left corner of the EVADE main window. The menu tabs open subwindows just below the tabs. When selected, these tab subwindows provide information and icon buttons to perform various actions Following are the available menu tabs (shown in Figure 53):

· Details

· Active Bookmarks

· Active Files

· Notes
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[bookmark: _Ref311799584][bookmark: _Toc327255178][bookmark: _Toc390083763]Figure 53. The information that is displayed on the Details tab.

[bookmark: _Toc376936741][bookmark: _Toc386204235][bookmark: _Toc390083252]Details

Clicking on the Details tab (Figure 53) opens a subwindow which provides information about the dust concentration data file. This is an informational tab only. No commands or preferences can be selected using this tab. The information listed includes:

Date:	The date in day, month, year format.

Model:	The model of the dust sampler being used, 1500-pDR, AM-510, or 1000-pDR.

Duration:	The length of the video and dust files in hours:minutes:seconds (hh:mm:ss).

Max:	The maximum dust concentration encountered in the dust concentration data file.

Max @:	The time (in hh:mm:ss format) in which the maximum dust concentration occurs.

Time:	The elapsed time (in hh:mm:ss format) as the video and dust graph are played.

Units:	The units of the dust concentrations in milligrams or micrograms. The concentration is either mg/m3 or µm/m3.

[bookmark: _Toc327255114][bookmark: _Toc376936742][bookmark: _Toc386204236][bookmark: _Toc390083253]Active Bookmarks

Clicking on the Active Bookmarks tab opens a subwindow which lists the five automatic bookmarks and any bookmarks that have been created by the user (Figure 54). The subwindow displays the following four columns:

· #. This column displays the bookmark number.

· Description. This column displays the descriptions of the five automatic bookmarks, which are automatically labeled Max# (for example, Max1 for bookmark 1, Max2 for bookmark 2, etc.). Also listed are the user-defined descriptions for bookmarks created by the user.

· Time. This column displays the location where the bookmark occurs in the data and video files.

· Reading. This column displays the dust concentration reading at the bookmark location in µg/m3, mg/m3, PPM, or % Concentration depending upon the units selected.

Once more bookmarks are created such that the bookmark list fills the subwindow display, a scroll up and down bar will appear on the right side of the interface. Click on the bar and move the vertical bar up or down to scroll up or scroll down through the bookmarks. Clicking on a bookmark highlights the bookmark, and the video screen and dust data graph advance to the bookmark location.

[bookmark: _Toc376936743][bookmark: _Toc386204237][bookmark: _Toc390083254]Delete Bookmarks

To delete a bookmark:

1. Right-click on a bookmark to display a dialog box with one option, Click to DELETE this Bookmark.

2. Click on this option to delete the selected bookmark.
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[bookmark: _Ref315694160][bookmark: _Toc327255179][bookmark: _Toc390083764]Figure 54. The Information displayed on the Active Bookmarks tab.

[bookmark: _Toc327255115][bookmark: _Toc376936744][bookmark: _Toc386204238][bookmark: _Toc390083255]Active Files

Clicking on the Active Files tab (Figure 55) opens a subwindow that lists the files used by EVADE for the present dust exposure analysis. This is an informational tab only. No commands or preferences can be selected using this tab. The information listed includes:

Directory:	Lists the directory of the active files being used by the EVADE software.

Video:	Lists the filename of the active video file being used.

Data:	Lists the filename of the active dust concentration data file being used.

Bookmark:	Lists the filename of the active bookmark file being used.

Additionally, exported bookmark files, screenshot files, and saved Notes files used for the current analysis will be listed in this area.
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[bookmark: _Ref311799863][bookmark: _Toc327255180][bookmark: _Toc390083765]Figure 55. Information displayed on the Active Files tab.

[bookmark: _Toc327255116][bookmark: _Toc376936745][bookmark: _Toc386204239][bookmark: _Toc390083256]Notes

Clicking the Notes tab opens a subwindow that allows the user to enter notes during the dust exposure analysis (Figure 56). To enter a note, just begin typing in the subwindow below the Notes tabs. Above this open area are six icon buttons, described next. Upon exiting EVADE, any notes are automatically saved to the default filename, which is described in the following Save As section.
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[bookmark: _Ref315694357][bookmark: _Toc327255181][bookmark: _Toc390083766]Figure 56. Example notes typed in the subwindow area below the Notes tab.

[bookmark: _Toc390083257]Icon buttons on the Notes Tab:

Starting on the left side of the menu bar in the Notes subwindow, the icon buttons are:

· Save As. Clicking on the Save As button opens the Save As window (Figure 57). The default file name displayed is the name of the video file with an rtf extension. Anything written in the Notes Tab will be automatically saved to this file name in rtf format. This default file will be overwritten automatically. You can edit the filename in this window if desired, to prevent overwriting previous notes or to make changes. Subsequent Save As default file names will include _V1 such that the filename will have the format filename_V1.rtf; the _V1 will increase to _V2, _V3, etc. as additional saves are completed. When EVADE is exited and re-opened, the EVADE program will display the notes from the original default filename (videofilename.rtf).
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[bookmark: _Ref355949220][bookmark: _Toc390083767]Figure 57. Display of the Save As dialog box when the Notes tab is selected

· Open RTF. Clicking on the Open RTF icon button (second icon from the left) allows you to open other previously created note files. A dialog box will open that allows the selection of a note file to be opened and displayed in the Notes tab. You can select the rtf file to open in the Notes tab. Opening an existing note file will clear any previous notes entered into the Notes menu tab.
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[bookmark: _Ref357006130][bookmark: _Toc390083768]Figure 58. The Open dialog box that opens after clicking the Open RTF button 
under the Notes tab.

· Place or Insert Frame Time. Clicking this icon button enters the time corresponding to the location of the vertical green bar on the dust data graph into the Notes subwindow (see the time displayed in green in Figure 58). Subsequent clicks of the Place icon will enter additional times which will be different from the original entered time if the video is playing.

· Bold, Italic, and Underline. These buttons are used to format the text similar to text formatting in a word processing program.

· Print. Clicking on the Print icon opens the Print dialog box which allows you to send the notes to a printer (Figure 59).
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[bookmark: _Ref326850245][bookmark: _Toc327255183][bookmark: _Toc390083769]Figure 59. Display of the Print dialog box from the Notes tab.




[bookmark: _Toc327255117][bookmark: _Toc376936746][bookmark: _Toc386204240][bookmark: _Toc390083258]Action Buttons

The action buttons are located on the left side of the main EVADE window below the tab subwindow area where information from the menu tabs is displayed. The action buttons can be used as shortcuts to conduct their specified operation. The following is a description of each button.

[bookmark: _Toc327255118][bookmark: _Toc376936747][bookmark: _Toc386204241][bookmark: _Toc390083259]Open File

Clicking on the Open File action button (Figure 60) displays the Open dialog box which allows you to open a previous dust exposure analysis (a shortcut instead of selecting the File menu and the Open command). The acceptable file types are the dcf files. When the Open dialog box opens, the displayed default directory is the EVADE directory. Other directories can be searched by browsing the directory box at the top of the Open dialog box. Selecting a dcf file will allow an evaluation using the previously associated dust concentration data and video files. (See the Open Command section in this document for additional information on the Open command.)
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[bookmark: _Ref311463725][bookmark: _Toc327255184][bookmark: _Toc390083770]Figure 60. The Open File action button (circled).

[bookmark: _Toc327255119]


[bookmark: _Toc376936748][bookmark: _Toc386204242][bookmark: _Toc390083260]New Project

Clicking on the New Project action button (Figure 61) is the same as selecting File from the menu bar and then selecting the New Project command. The New Project command opens the Create New EVADE Project dialog box (Figure 62), allowing you to create a new dust exposure analysis.
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[bookmark: _Ref311467349][bookmark: _Toc327255185][bookmark: _Toc390083771]Figure 61. The New Project action button (circled).

[bookmark: _Toc327255120][image: ]

[bookmark: _Ref355949471][bookmark: _Toc390083772]Figure 62. The Create New EVADE Project dialog box when the New Project icon 
button is selected.

[bookmark: _Toc376936749][bookmark: _Toc386204243][bookmark: _Toc390083261]Play

Clicking on the Play action button (Figure 63) starts the video playback and allows you to conduct the dust exposure analysis for the job occupation. You can also select Play from the Playback menu on the menu bar.
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[bookmark: _Ref311469410][bookmark: _Toc327255186][bookmark: _Toc390083773]Figure 63. The Play action button (circled).

[bookmark: _Toc327255121]


[bookmark: _Toc376936750][bookmark: _Toc386204244][bookmark: _Toc390083262]Pause

Clicking on the Pause action button (Figure 64) stops the video at its current location. Clicking on the Play icon button will restart the video at the currently stopped location. You can also select Pause from the Playback menu in the menu bar.
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[bookmark: _Ref311469494][bookmark: _Toc327255187][bookmark: _Toc390083774]Figure 64. The Pause action button (circled).

[bookmark: _Toc327255122]


[bookmark: _Toc376936751][bookmark: _Toc386204245][bookmark: _Toc390083263]Stop

Clicking on the Stop action button will stop the video playback and reset the video and dust concentration graph to the beginning (Figure 65). Clicking on the Play icon button will restart the video, but it will restart at the beginning. You can also select Stop from the Playback menu in the menu bar.
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[bookmark: _Ref326927835][bookmark: _Toc327255188][bookmark: _Toc390083775]Figure 65. The Stop action icon button (circled).

[bookmark: _Toc327255123]


[bookmark: _Toc376936752][bookmark: _Toc386204246][bookmark: _Toc390083264]Audio On/Off

Clicking on the Audio On/Off (or Mute) action button (Figure 66) will toggle between the sound being on or off. Clicking on this button will have no effect if the sound was turned off during video recording. You can also select Audio On/Off from the Playback menu in the menu bar.
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[bookmark: _Ref311470788][bookmark: _Toc327255189][bookmark: _Toc390083776]Figure 66. The Audio On/Off (or Mute) icon button (circled).

[bookmark: _Toc327255124][bookmark: _Toc376936753][bookmark: _Toc386204247][bookmark: _Toc390083265]Zoom Bar

A Zoom bar (Figure 67) is located directly above the action buttons. Sliding the bar horizontally to the left or right will change the X-axis scale of the dust data graph. Following are ways to use the Zoom bar to read the dust concentration data graph:

· Sliding the Zoom bar to the right will shorten the X-axis scale resulting in the dust data being displayed over a short interval. The dust data will look very condensed.

· Sliding the bar to the left will lengthen the X-axis scale resulting in the dust data being displayed over an expanded interval. Lengthening the X-axis scale will allow you to better conduct the dust exposure analysis as you will more easily follow the individual real-time dust concentrations.

· Another method that can be used to expand or contract the scale of the x-axis is to use the scroll button on the mouse while the cursor is located in the dust data concentration graph.

[image: ]

[bookmark: _Ref311471147][bookmark: _Toc327255190][bookmark: _Toc390083777]Figure 67. The Zoom bar and Options button (circled).

[bookmark: _Toc376936754][bookmark: _Toc386204248][bookmark: _Toc390083266]Options Button

Clicking on the Options button to the right of the Zoom bar opens the Graph Options dialog box (Figure 68). See the Graph Options section in this document for detailed information on the Graph Options dialog box.
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[bookmark: _Ref357060783][bookmark: _Toc390083778]Figure 68. Display of the Graph Options dialog box when selecting the Options button 
to the right of the Zoom Bar.

[bookmark: _Toc376936755][bookmark: _Toc386204249][bookmark: _Toc390083267]Graph Viewing Area

The graph viewing area, located at the bottom of the main EVADE window (Figure 69), contains the dust concentration data as a line plot. The graph contains the following features:

· The blue line in the graph is the dust concentration data.

· The X-axis of the graph contains the timeline of the video file in hours:minutes:seconds format.

· The Y-axis contains the dust concentrations in either µg/m3 or mg/m3, PPM, or % Concentration, depending on the units selected.

· An important feature of the graph is the green vertical line. This green line indicates the current time and position of the video and dust concentrations. The current time is highlighted by the time display outlined in the x axis. The reading above the green vertical line just above the graph is the dust concentration at that moment. The video displays the current action occurring at the green vertical line.

· The red vertical lines are the bookmarks. There are five automatic bookmarks selected at the five highest dust concentrations. These bookmarks are labeled Max1, Max2, Max3, Max4, and Max5.

The graph will automatically scroll during video playback, showing the current dust concentration on the graph coordinated with the current action being displayed on the video.

To fast forward or fast reverse the video and dust concentration data graph together, do one of the following:

· Use the slider bar directly below the video display dragging it to the left or right.

· To fast forward, left-click on the dust data graph and hold down the mouse click while dragging the mouse to the right. To fast reverse, left-click on the dust data graph and hold down the mouse click while dragging the mouse to the left.

Do one of the following to expand or decrease the X-axis scale of the dust concentration graph:

· Place the mouse cursor in the graph area and scroll the mouse forward with the mouse wheel to increase the X-axis scale of the graph. Scrolling backwards with the mouse wheel decreases the X-axis scale.

· Sliding the zoom bar to the right decreases the X-axis scale, while sliding it left increases the X-axis scale.

[image: ]

[bookmark: _Ref370899265][bookmark: _Toc390083779]Figure 69. The EVADE main window after either the New Project or Open command 
under the File menu is used to set up a new dust exposure analysis.

[bookmark: _Toc376936756][bookmark: _Toc386204250][bookmark: _Toc390083268]Video Display Area

The video display, located just above the dust concentration graph (Figure 69), shows the current actions in the video that correspond to the dust concentration at the green vertical bar on the graph. Fast forwarding or fast reversing is accomplished by placing the cursor on the dust concentration graph and left-clicking the mouse while dragging the dust concentration data graph as previously mentioned for the dust data graph

Fast forward or fast reverse through the video and dust concentration data can also be accomplished through the use of the slider bar located directly below the video display (Figure 70). Left-clicking on the slider bar and dragging it to the right will fast forward the video and corresponding dust concentration data. Dragging the slider bar to the left will fast reverse the video and corresponding dust concentration data.
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[bookmark: _Ref370899347][bookmark: _Toc390083780]Figure 70. Display showing the location of the slider bar below the video display.

Another way to fast forward or fast reverse through the video is to use the left or right arrow keys on the keyboard. The right arrow key will advance the video and graph approximately 10 seconds each time the key is pressed. The left arrow key will reverse the video approximately 10 seconds each time the key is pressed. These keys will work only during playback of the video.




[bookmark: _Toc376936757][bookmark: _Toc386204251][bookmark: _Toc390083269]Data File: EVADE’s Universal Format

EVADE’s universal format data file is a four-column file format which allows you to input data from sources that cannot normally be read by EVADE. The four columns of EVADE’s universal format data file are shown in Figure 71, in the following order (from left to right): data point #, date, time, and concentration.
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[bookmark: _Ref349312186][bookmark: _Toc390083781]Figure 71. A screenshot of a dust concentration file in EVADE’s universal format 
opened in WordPad.

EVADE’s universal file format is a comma delimited (csv) file and does not contain any header information. This file can easily be created in Microsoft Excel as long as the resulting file is saved as a csv file.

When opening a new EVADE analysis, the software will automatically detect this universal format file. Once detected, a dialog box will open (Figure 72) which contains the following input fields:

· Instrument model. This field provides a blank space where you input the instrument model number or identification number. In the example, “test” is used for the instrument model number.

· Measurement units. In this field, you click in the checkbox to select the units of the dust concentration data. You can select one of the following options: % concentration, PPM, ug/m3 or mg/m3. This selection allows EVADE to display the concentration in the proper units.

The units ug/m3 and mg/m3 are the common units of concentration for dust sampling. The units % concentration and PPM are offered to allow the user to use EVADE to analyze exposure sources for other substances (e.g., gas and fumes). The user is responsible for obtaining the concentration data for the other substances to be analyzed and knowing the proper units of the data. Unit conversion between ug/m3 and mg/m3 is available in EVADE. However, there is no unit conversion available between % concentration and PPM.

[image: ]

[bookmark: _Ref362366112][bookmark: _Toc390083782]Figure 72. The dialog box that opens when EVADE’s universal file format is detected 
with the dust concentration data file.

[bookmark: _Toc327255132][bookmark: _Toc376936758][bookmark: _Toc386204252][bookmark: _Toc390083270]Editing Dust Concentration Data Files

The dust concentration data file downloaded from the three real-time datalogging aerosol monitors (pDR-1000, pDR-1500, or AM-510) or in universal format is directly input in EVADE which allows display of the dust concentrations and the dust concentration graph during playback of the video. There may be times that the data may need to be edited, such as editing for negative dust concentration values, truncating dust data files that are longer than video files or modifying the start time to coincide with the video start time. To maintain file integrity, it is not recommended to edit the header information in the file. Microsoft Excel does not allow for ease of editing of the csv data file because saving as a csv file in Excel removes the column width formatting.

WordPad or Notepad can be used to edit the dust concentration data files. WordPad will allow saving the edited data file with the correct columnar format as a text file (txt), Notepad will allow saving the edited data file with the correct columnar format as a print file (prn). It is important that the file be saved as a csv file. This can be accomplished easily by adding the extension csv at the end of the file name when saving the file. For example, Figure 73 displays a typical pDR-1500 dust concentration file opened in WordPad. The header information is located in the first 24 lines of the file with the dust concentration data listed beginning on line 25.

To edit the data file, open the data file to be edited in WordPad or NotePad. At this time any edits to the file can be completed. For example, if correction for the negative value of respirable dust concentration is needed, make the edits by seeking the negative value. Delete the negative sign in front of the dust concentration and replace it with a space.

Changing the start time of the dust data file is more complex. If the start time of the data file needs to be changed, entire data lines can be deleted or added until the correct start time is listed underneath the header information. It is important that the entire line be added or deleted while maintaining the line format (correct number of characters/line). Additionally, in the header information there is a line labeled “number.” The actual number in this line will need to be changed to reflect the actual number of data points/lines in the file.

Once the edits are complete, the data file can be saved. It is best to save the newly edited file with a new name to ensure the original file does not become corrupted. When saving the new file, save it as a csv file, not as a txt or prn file.

[image: ]

[bookmark: _Ref305600075][bookmark: _Toc327255194][bookmark: _Toc390083783]Figure 73. A typical pDR-1500 data file displayed in WordPad.

 


[bookmark: _Toc327255129][bookmark: _Toc376936759][bookmark: _Toc386204253][bookmark: _Toc390083271]Troubleshooting

This section includes two examples of problems you might encounter while using the EVADE software, and actions for resolving these situations are provided.

[bookmark: _Toc327255130][bookmark: _Toc376936760][bookmark: _Toc390083272]Program works as expected, but no video is displayed

If the program appears to be functioning normally, dust and video data are loaded, but no video is displayed, the most likely cause is a missing or incorrect video codec. There are several possible solutions to this problem.

If you have not already done so, try installing the DivX or Xvid codec (see the Installing the EVADE Software Program section in this document for details), or install the software that came with your camera.

If this does not fix the problem, verify that the video file can be played back in Windows Media Player. First, launch Windows Media Player from the Start menu, then locate your video file and drag-and-drop the video file onto the Windows Media Player window. If the video does not play, it’s possible the file is damaged, or the video codec used by the file is not supported by the installed codecs. Try playing other video files from the camera in Windows Media Player; if none of them display video during playback, try uninstalling and reinstalling the camera’s software and/or the DivX or Xvid codec.

If the video plays in Windows Media Player, but not in EVADE, it’s possible that one of the video codecs installed on the system is incompatible with EVADE. Information about what codecs are in use can be viewed by opening the Help menu and choosing Video Playback Details which will display a list of the active codecs being used by EVADE. If any third party codecs show up here, it may be necessary to uninstall them and install DivX, Xvid, or another codec.

Another solution to correct this video problem is to convert the avi video file into a wmv file. This can be accomplished using separate third-party software. The EVADE video display is based upon the Windows Media Player and should play the wmv file.

[bookmark: _Toc327255131][bookmark: _Toc376936761][bookmark: _Toc390083273]Video playback works initially and then stops moving

In some cases, most often after scrolling quickly from one location to another or rapidly playing/pausing, the video playback can freeze and refuse to play/seek to a new location. In most cases this can be fixed by stopping the video and pressing Play again from the Playback menu. If this does not fix the problem, close the program by clicking on Exit from the File menu, and restart EVADE.

If this happens frequently, it may be due to the video codec being used (such as DIVX, XVID, etc.). You could try uninstalling your current video codec and installing a different one. The codec XVID was found to perform better, eliminating video freezing, during initial software testing.

Another cause could be that the SD card used in the video camera may not have sufficient read/write speeds which can result in dropped video represented by video stoppages during playback. Use an SD card of class 6 or higher which has higher read/write speeds to prevent dropped video.
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